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1 Program Introduction 
 

This program provides efficient control of CT, Panorama and Cephalo images acquired by operating 

the RayScan Alpha System manufactured by RAY Co., Ltd and various image analysis functions 

(exclude CT images) depending on the diagnostic goal. Use the oral sensor and oral camera to 

obtain images easily and view images in FMX (Full Mouth X-ray) format conveniently as well as 

manage digitalized film images through the use of images obtained by scanner. 

 

1.1 Program Features 

 Convenient and Stable Network Environment 

Images can be accessed using SMARTDent from any PC connected to the network through 

a Web service based DBMS(Database Management System) and large image information 

is also safely managed. In addition, the software supports a function that transmits images 

to PACS system through the DICOM SCU service. 

 Touch environment considered Simple UI 

Functions are easily and quickly learned for use through a minimized user interface design 

based on user experience and it is easily operated in Slate PC as well as Tablet PC which 

uses the Microsoft Windows operating system. 

 Convenient Image Analysis 

Diverse Multi-view formats are supported to allow efficient pre/post treatment image 

comparisons and several images can easily be analyzed on one screen. 

 Addition of a Simple Implant Library  

Image based implant library function is supported for simple addition of implants supplied 

by various manufacturers and by using the user implant function, a new implant may be 

created for implant simulation.  
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 DICOM 3.0 Compatibility 

SMARTDent support the DICOM file format recognized as the standard medical image file. 

DICOM SCU, DICOM Worklist & DICOM Print functions are supported for easy interworking 

between RayScan Alpha System and PACS system. 

 Import/Export 

SMARTDent supports Import and Export functions for various file formats such as DICOM, 

raw and jpg. 

 Alternative Program Links 

In addition to a link to 3D Viewer (Xelis) and orthodontic analysis program (V-Ceph). 

 

 

1.2 Operating Environment 

Class Minimum Requirements Recommended Specifications 

CPU Pentium 4 or higher Intel i5 or higher 

RAM 1GB or more 2GB or more 

Resolution 1024 X 768 or higher 1280 X 800 or higher 

Video Video Card with over 64MB RAM Video Card with over 512MB RAM 

Operating 

System 

Windows XP Home Premium  

+ Service Pack 3 

Windows 7 Professional 
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1.3 System Configuration 

Complete configuration of the RayScan Alpha System are as follows. 

 

 

‘RayScan’, ‘SMARTDent’ program constructs a network along with the Web Service based server 

enabling all images used at the dental practice to be obtained and saved in addition to viewing 

images stored in the server from a PC where SMARTDent is installed. (Server, RayScan and 

SMARTDent program may be installed in a single PC.)  

Web Service based server is where the patient information and image data are stored and by using 

the Workstation RayScan program, obtain CT, Panorama and Cephalo images from the RayScan 

Alpha equipment. Workstation or Chair PC SMARTDent supports the oral sensor image acquisition 

function and SMARTDent of the Chair PC is capable of obtaining the oral camera images. 

Inquire patient information and analyze images from all PCs installed with SMARTDent in network 

environment and image analysis data entered using SMARTDent may be checked from any PC. 
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1.4 Program Configuration 

SMARTDent is composed of 5 tabs and main functions of each tab are as follows. 
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2 Patient Administration 
 

Use SMARTDent to search for patients registered in the RayScan Alpha System or execute functions 

such as new patient registration, patient information modification or delete. 

Patient search is performed by entering patient ID or name to inquire the patient and frequently 

used period search button like Today, 3 days or 1 week is used to search for the latest visiting 

patients conveniently. Specify Modality (imaging type) to search only the patients undergone the 

applicable Modality and by setting Modality in conjunction with the period, lookup patients who 

have been scanned for specified images during a prescribed period.  

Retrieved patient list indicates patient ID, name, gender, date of birth as well as number of each 

Modality scans for easy understanding of the scan status of each patient, also select a patient and 

choose either oral sensor imaging, oral camera imaging or Export button from below to immediately 

execute functions of the applicable button. 

Screen composition of the ‘Search’ tab and contents of each item are as follows. 

 

Figure 1.  ‘Search’ Tab screen 

 

Patient List 

Bottom 

Search Bar 
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Search Bar 

 

Item Description 

From Setup beginning date of the period to be searched. 

To Setup ending date of the period to be searched. 

Patient ID Patient ID 

Patient Name Name of the patient 

Modality Scan type 

Today Search for a list of patients registered or scanned today. 

3 days Search for a list of patients registered or scanned within 3 days. 

1 week Search for a list of patients registered or scanned within 1 week. 

2 weeks Search for a list of patients registered or scanned within 2 weeks. 

1 month Search for a list of patients registered or scanned within 1 month. 

3 months Search for a list of patients registered or scanned within 3 months. 

1 year Search for a list of patients registered or scanned within 1 year. 

Calendar Calendar display button 

Clear All Delete specified search criteria and return to initial condition. 

Search Search the scan list using a specified search criteria.  

 

Patient List 

 

Item Description 

Patient ID Patient ID 

Patients Name Name of the patient 

Patients Sex Gender of the patient 

Patients Birth Date  Patient’s date of birth 

PX Number of Panorama image scans 

CT Number of CT image scans 

DX Number of Cephalo image scans 

IO Number of oral sensor image scans 

OT Number of oral camera image scans 
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Bottom  

-Standard 

 

-Buttons shown below are activated during patient list selection.  

 

Item Description 

CT acq. Select patient then click to call RAYSCAN for CT acquisition. 

Pano acq. Select patient then click to call RAYSCAN for Pano acquisition. 

Ceph acq. Select patient then click to call RAYSCAN for Ceph acquisition. 

Sensor acq. Select patient then click to convert to screen for oral sensor imaging. 

Camera acq. Select patient then click to convert to screen for oral camera imaging. 

New Button for adding new patients. 

Modify Button for modifying selected patient information. 

Delete Button for deleting selected patient information. 

Export Select patient then click to convert to the Export screen. 

Open Select patient then click to Open patient and convert to image view 

screen. 

 

 

2.1 Search Patient 

From the ‘Search’ tab screen, setup the search criteria to search for the patient. 

‘Search by Patient ID, Name’ where search is conducted by entering patient ID or name of the 

patient intended for search is entered, ‘Search by using the period search button’ in which the 

patient having undergone imaging during a specified period is searched, ‘Search by setting user 

period’, where patients having obtained images during an arbitrary period is searched and  ‘Search 

by Modality’ function which searches for patients having obtained a specified image are supported.  

 

TIP 

Select Modality then setup Period for search enabling easy search of patients having 

been scanned for certain images during the specified period.   

※2.1 Patient Search  Search by Modality 
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Search by Patient ID, Name 

No. Figure Description 

1  

Enter patient ID or name of the patient 

intended for search in ‘Patient ID’ or ‘Patient 

Name’ field located on upper center of the 

screen.  

 

Tip – Entering first letter of the patient name 

or ID will retrieve list of patients 

whose name begins with the 

applicable letter.  

 

Caution – Entry of less than 50 characters, 

Eng∙Numbers∙Chinese characters∙ 

Japanese / Special characters ‘-

‘(Hyphen), ‘,’(Comma), ‘.’(Period), 

and Space key are permitted. 

2 

 

Click the [Search] button on upper right side  

of the screen. 

3 

 

Retrieved patient information is displayed on 

the patient list. 

 

Tip – Click ’ Patient ID, Patients Name, 

Patients Sex, Patients Birth Date, PX, 

CT, DX, IO, OT’ on top of the patient 

list to arrange the patient list 

according to the applicable item. 
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Search using the Period Search button 

No. Figure Description 

1 

 

Press the ‘Period Search’ button on top right 

side of the screen.  

 

Tip – Total of 7 different period search 

function (Today, 3 days, 1 week,  

2 weeks, 1 month, 3 months,  

1 year) are provided. 

2 

 

Retrieved patients are displayed on the patient 

list. 

 

 

Search by setting the User Period 

No. Figure Description 

1 

 

Click the [Calendar] button of the ‘From’ 

category on upper left side of the screen and 

in the appearing calendar, select the search 

begin date. 
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2 

 

Click the [Calendar] button of the ‘To’ category 

on upper left side of the screen and in the 

appearing calendar, select the search end date. 

3 

 

Click the [Search] button located on upper 

right side of the screen. 

4 

 

Retrieved patients are displayed on the patient 

list. 

 

 

Search by Modality 

No. Figure Description 

1 

 

Select the search desired ‘imaging type’ in the 

‘Modality’ item located on upper center of the 

screen.  

 

Tip – Imaging type: All, CT, Pano(Panorama), 

Ceph(Cephalo), Intraoral, 

Other(Camera) 
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2 

 

Click [Search] button or ‘Shortcut period 

search’ button located on upper center of the 

screen.  

 

Tip – Clicking the [Search] button will search 

for patients having had the applicable 

Modality scan from the entire patient 

list. 

Click the [1 week] button to search for 

patients having been scanned for the 

applicable Modality among all patients 

visiting the practice within 1 week. 

3 

 

Retrieved patients are displayed on the patient 

list. 

 

 

2.2 Register New Patient 

‘RayScan Alpha System’ allows new patient information registration through patient registration 

function or DICOM Worklist of RayScan Program. 

The method for registering new patients in SMARTDent is described below. 

Click [New] from the ‘Search’ tab screen then the ‘New Patient’ window will appear.  
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그림 1 New Patient (Full Name Format) 

 

 

 

Header 

Contents 

Bottom 



SMARTDent  l  Patient Administration  

19 

 

그림 2  New Patient (Last/First Name Format) 

 

Details of the ‘Contents’ category in the ‘New Patient’ window are as follows. 

 

Contents 

Item Description 

Patient ID Patient ID 

Auto Patient ID Auto Create button 

First Name First name of the patient 

Middle Name Middle name of the patient 

Last Name Last name of the patient 

Patients Sex Gender of the patient 

Patients Birth Date Patient’s date of birth 

Calendar Calendar display button 

 

 

 

 Contents 

Header 

Bottom 
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Register New Patient 

No. Figure Description 

1 

 

Click the [NEW] button located on right bottom 

side of the screen. 

2 

 

Enter ‘Patient ID’ in the New Patient registration 

window. 

 

Tip – Create ‘Patient ID’ automatically by 

clicking the [Auto] button. 

 

Caution – Entry of less than 20 characters, 

English∙Numbers∙Chinese 

characters∙Japanese / Special 

characters ‘-‘(Hyphen), ‘,’(Comma), 

‘.’(Period), Space key is permitted. 

3 

 

Enter ‘Patient Name’ in the New Patient 

registration window. 

 

Caution – Patient name input criteria: less 

than 50 characters, English∙ 

numbers∙Chinese characters∙ 

Japanese/ Special characters  

‘-‘(Hyphen), ‘,’(Comma), ‘.’(Period),  

And space key are permitted. 
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4 

 

Enter ‘Year, Month, Date of birth’ in the New 

Patient registration window. 

 

Caution - The setting for Child is 

distinguished by age of the patient 

therefore accurately enter the date 

of birth. (Cut-off for Child is 12 

years of age) 

5 

 

Select ‘Gender’ from the New Patient 

registration window. 

 

Tip - Type: [Standard] Male, Female, Other  

(-ex)Emergency) 

6 

 

When patient information entry is completed, 

click the [OK] button.  

7 

 

Verify creation of a new patient from the 

patient list. 
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2.3 Modify Patient Information 

Select patient from the ‘Search’ tab screen then click [Modify] to modify patient information. 

 

CAUTION 

Patient information of a patient who has scanned image or order, may not be 

modified.   

Please check patient information prior to an capture request. 

 

If select patient and click [Modify] button from Search tab, ‘Modify’ window will appear. 

 

Figure 2.  Modify message 

 

If select [Yes] button from ‘Modify’ window ‘Modify Patient’ window will appear.. 
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Figure 3.  Modify Patient 

 

Details of the ‘Contents’ category in ‘Modify Patient’ window are as follows. 

 

Contents 

Item Description 

Patient ID This item is not subject to modification.  

Auto This item remains inactive.  

First Name First name of the patient 

Middle Name Middle name of the patient 

Last Name Last name of the patient 

Patients Sex Gender of the patient 

Patients Birth Date Patient’s date of birth 

Calendar Calendar display button 

Portrait of Patients Portrait of Patients 

Portrait of Patients Portrait of Patients button 

 

 

 

Header 

Contents 

Bottom  
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Modify Patient Information 

No. Figure Description 

1 

 

Utilize the patient search function to look-up 

the patient whose patient information requires 

modification then select the appropriate patient 

list. 

2 

 

Click the [Modify] button located on bottom 

right side of the screen. 

3 

 

Click [Yes] button.  

4 

 

Revise changes in the Modify Patient 

information window. 

 

Notice – To prevent wrongful usage, 

SMARTDent does not support 

modification of the Patient ID.  

When Patient ID modification is 

required, please contact the 

customer service center. 
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5 

 

When all patient information are entered,  

click the  [OK] button.  

6 

 

Verify modification of the patient information 

from the patient list. 

 

 

2.4 Delete Patient 

Select patient from the ‘Search’ tab screen then click the [Delete] button to delete the selected 

patient.  

CAUTION If delete patient, the patient’s information will be deleted. 

 

If select a patient and click [Delete] button from Search tab ‘Password’ window will appear.. 
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Figure 4.  Password window 

 

If insert password and press ‘Enter’ or click ‘OK’ button, ‘Delete’ button will appear. 
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Figure 5.  Patient Delete 

 

Contents 

Item Description 

Message Delete confirm message display 

 

If click ‘Yes’ button patient information will be deleted. 

  

 

 

 

Header 

Contents 

Bottom 
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Delete Patient 

No. Figure Description 

1 

 

Utilize the patient search function to search for 

the patient whose information must be deleted 

then select the appropriate patient list. 

2 

 

Click the [Delete] button located on bottom of 

the screen.  

3 

 

When delete a patient insert password. 

 

Notice – The password is “SymphonY” and  

case-sensitive.. 

4 

 

When Delete confirmation pop-up window 

appears, click [Yes]. 

 

Notice – All information will be deleted 

include acquisition images. 
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5 

 

Confirm that applicable patient list is deleted 

from the patient list. 

 

 

2.5 Portrait of patients 

If click [New] button from Search tab ‘New Patient’ window will appear.  

Click [Modify] button to portrait image for existing patient. 

 

If click Portrait button from New Patient window ‘Portrait Of Patient’ window will appear. 

 

Notice If there is no acquisition image or file default image will be shown instread. 
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Figure 6.  New Patient 

 

 

Buttom 

Item Description 

Portrait  Portrait of patients 

You can register a patient’s photo by taking a photo or bringing image. 

 

Notice If there is no available acquisition device you only use [File] tab.  

 

 

 

 

Header 

Contents 

Bottom 
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Figure 7.  Portrait of patients 

 

Right 

Item Description 

Device list Show connected devices (It is disabled in File tab) 

Acquisition 

Search 

(Show  icon in ‘Acquisition’ tab) save current display 

(‘Show  icon in ‘File’ tab) Search file 

OK Save patient’s information 

Cancel Cancel saving patient’s information 

 

 

  

 

 

 

Header 

Content 

Right 
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Register portrait by taking photo 

No. Figure Description 

1 

 

Click the [New] button. 

2 

 

Click the [Portrait] button. 

3 

 

If webcam is connected ‘Acquisition’ tab will be 

activated automatically  

 

 

If click [Capture] button current display will be 

captured. 

Notice – If click [OK] button current display 

will be saved. 



SMARTDent  l  Patient Administration  

33 

5 

 

Move the rectangle which is setting “Image 

range” and click [OK] button.  

6 

 

You can check the photo in ‘New Patient’ 

window  

After check the photo click the [OK] button. 

7 

 

If click ‘Thumbnail’ mode from Search tab you 

can check portrait of patients. 

 

 

Register portrait by bringing image 

No. Figure Description 

1 

 

Click [New] button 
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2 

 

Click [portrait] button 

3 

 

Click [Search] button from File tab to bring 

image  

 

Notice – If webcam is connected real-time 

shooting is possible. 

4 

 

Move the rectangle which is setting “Image 

range” and click [OK] button. 

 

Notice – If click [OK] button current display 

will be saved. 

5 

 

You can check the photo in ‘New Patient’ 

window  

After check the photo click the [OK] button. 
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6 

 

If click ‘Thumbnail’ mode from Search tab you 

can check portrait of patients. 

 

 

2.6 CT Acquisition 

Click ‘CT Acq.’ Button. It calls RAYSCAN for CT Acquisition.  

If CT Acquisition is completed normally, RAYSCAN will be shutdowned automatically and 

SMARTDent shows the images. 

 

Notice If Server and RAYSCAN do not exist in local PC, you cannot use this function. 

 

CT Acquisition 

No. Figure Description 

1 

 

Click the patient for CT Acquisition.  

If the [CT Acq.] button is active click it. 
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2 

 

RAYSCAN will be shown and you can click the 

protocol for CT Acquisition. 

3 

 

If CT Acquisition completed, then click the 

[Comfirm] button. RAYSCAN will shutdown 

automatically and SMARTDent will show the 

image(s) in Image tab. 

 

Notice – If CT Acquisition is canceled or an 

error occurs SMARTDent will not 

show the image(s).  

 

 

2.7 Pano Acquisition 

Click ‘Pano Acq.’ Button. It calls RAYSCAN for Pano Acquisition.  

If Pano Acquisition is completed normally, RAYSCAN will be shutdowned automatically and 

SMARTDent shows the images. 

 

Notice If Server and RAYSCAN do not exist in local PC, you cannot use this function. 
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Pano Acquisition 

No. Figure Description 

1 

 

Click the patient for Pano Acquisition.  

If the [Pano Acq.] button is active click it.  

2 

 

RAYSCAN will be shown you can click the 

protocol for Pano Acquisition. 

3 

 

If Pano Acquisition completed, then click the 

[Comfirm] button. RAYSCAN will shutdown 

automatically and SMARTDent will show the 

images in Image tab. 

 

Notice – If Pano Acquisition is canceled or an 

error occurs SMARTDent does not 

show the images. 

 

 

2.8 Ceph Acquisition 

Click ‘Ceph Acq.’ Button. It calls RAYSCAN for Ceph Acquisition.  

If Ceph Acquisition is completed normally, RAYSCAN will be shutdowned automatically and 

SMARTDent shows the images. 
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Notice If Server and RAYSCAN do not exist in local PC, you cannot use this function. 

 

 

Ceph Acquisition 

No. Figure Description 

1 

 

Click the patient for Ceph Acquisition.  

If the [Ceph Acq.] button is active click it.  

2 

 

RAYSCAN will be shown and you can click the 

protocol for Ceph Acquisition. 

3 

 

If Ceph Acquisition completed, then click the 

[Comfirm] button. RAYSCAN will shutdown 

automatically and SMARTDent will show the 

images in Image tab. 

 

Notice – If Ceph Acquisition is canceled or an 

error occurs SMARTDent does not 

show the images. 
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Image Management 

3 
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3 Image Management 
 

‘SMARTDent’ provides a function that comprehensively controls all images used by dental practices.  

Enables optimized decipher of panorama, cephalo and intraoral sensor x-ray images in accordance 

with the diagnostic goal and through the use of length measurement, angle measurement and 

implant simulation functions, images may be analyzed and treatment plan can be established. 

Use the various Multi-view functions to compare and analyze pre/post treatment of the same 

modality image. Functions that can construct images of various types on one screen, text insert and 

line drawing functions can be utilized for more efficient consult with the patients.  

SMARTDent link to the VCeph which is orthodontic analysis and simulation program, and Xelis 

which is CT image diagnosis and simulation program. So it supports for convenient diagnosis of 

Cephalo, CT image as well as cephalometric analysis, CT image analysis and simulation functions. 

Screen composition of the ‘Image’ tab and description of each item are as follows. 

 

Figure 8.  'Image' tab screen 

 

 

 

 

 

Image View 

   Patient List 

Toolbar 

Top Menu 

Overlay Tool 

Patient Information 

Image Information 

Patient Position 

Patient Position 

Palette 

Thickness 
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Top Menu 

 

Item Description 

 
Previous Series 

Shows the previous image of the currently selected image in the 

lower screen Thumbnail View. 

 
Next Series 

Shows the image following the currently selected image in th 

lower screen Thumbnail View. 

 
Basic View 

Displays a single image on one screen in basic layout. 

 
Vertical 2 View 

2 images separated vertically are displayed. 

 
Horizontal 2 View 2 images separated horizontally are displayed. 

 
Vertical 3 View 

Screen is divided into 3 sections; upper, lower left and lower 

right displaying 3 images. 

 
Horizontal 3 View 

Screen is divided into 3; left, upper right and lower right 

displaying 3 images. 

 
4 View 

4 images dividing the screen into up, down, left and right are 

displayed. 

 
Full Screen 

Displays the selected image on the full screen. 

 
Save 

Saves the Measure, Annotation and Windowing value of the 

currently selected image. 

 
Print  

Prints the image of the presently selected image. 

 

Image View 

Item Description 

Image View 

Displays the selected image.  

Upto 4 images can be viewed and by displaying 4 different images, 

they may be compared and analyzed. 

Patient Position Displays position information of the patient.  

Patient Information 
Displays the patient information. 

Displays patient ID, patient name, date of birth and Protocol. 

Image Information 
Displays the image information. 

Displays Window Center, Window Width, Zoom Ratio and Length Unit. 
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TIP Press the Patient Information and Image Information buttons to fold and unfold. 

 

NOTICE 
Patient position information is classified into the following. 

[L]: Left, [R]: Right, [F]: Feet, [H]: Head, [A]: Anterior, [P]: Posterior 

 

 

Protocol is a further detailed imaging mode of Modality and are classified into the 

following. 

PX – Normal, TMJ, Pedodontics, Sinus 

CT – Standard, Implant Surgery, Surgical Guide, Endo Treatment, CT TMJ, CT Sinus 

DX – Lateral, PA/AP, SMV, Carpus, Waters, Reverse-Towne 

IO/OT – Tooth number 

 

Tool bar 

Item Description 

 

Control Toolbar 

Collection of functions that control the basic image display such 

as move, rotate, zoom and shrink of the patient’s images.  

Press this button to expand on detailed functions for use and 

press again to hide the detailed functions.  

 
Select 

Select the image in standard selection enabled status or choose 

the displayed Measure or Annotation. 

 
Panning 

Provides a function capable of moving the image shown on 

screen. 

 
Zoom 

Provides a function capable of enlarging or shrinking the image 

shown on screen. 

 
Rotate 

Provides a function that can rotate the image shown on screen  

90 degrees in clockwise direction.  

When image is rotated then the patient position information is 

also changed when displayed. 

 
Mgnify 

Provides a function which enlarges portion of the image shown 

on screen.  

 
Vertical Flip 

Provides a function that turns upside down the image shown  

on screen. 

Patient position information change coincides with the image 

alteration when displayed. 
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Horizontal Flip 

Function reverses left and right side of the image shown on 

screen. Patient position information change coincides with the 

image alteration when displayed. 

 
Vertical Fit on 

Size of the image displayed on screen is adjusted to fit the 

vertical size of the screen.  

 

Horizontal  

Fit on 

Size of the image displayed on screen is adjusted to fit left and 

right side of the screen. 

 
Initialize Control 

Changes for imaging effects that are standard functions such as 

move, rotate, zoom and shrink to patient’s images are initialized. 

 

Process Toolbar 

Collection of functions that can modify Windowing adjustment 

and Image Processing to images of the patient.  

Press this button to expand the detailed functions for use and 

press again to hide the detailed functions. 

 
Select 

Select the image in standard selection enabled status or choose 

the displayed Measure or Annotation. 

 
Color mapping 

Provides a function that changes the color of the images to a 

specified color for display. 

 
Windowing Changes Windowing of the image currently on screen. 

 
Invert Inverts color of the image currently shown on screen. 

 
Median 

Applies Median filter to the image currently shown on screen to 

smooth out the overall image. 

 
Sharpen 

The image currently shown on screen is clearer overall by 

applying the Sharpen filter. 

 

Initialize 

Process 

All imaging process applied to the patient image displayed on 

screen is initialized. 

 

Measure 

Toolbar 

Collection of functions that can add or delete the length,  

angle and Implant to the patient image. 

Press this button to expand the detailed functions for use and 

press again to hide the detailed functions. 

 
Select 

Select the image in standard selection enabled status or  

choose the displayed Measure or Annotation. 

 
Multi Angle 

Provides a function that shows value of the angle to the patient 

image displayed on screen.  

 
Length 

Provides a function that shows the length value to the patient 

image displayed on screen.  

 
Multi Length 

Provides a function that shows multiple length values on the 

patient image displayed on screen. 

 
Implant Provides a function that shown the Implant on the patient image 
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displayed on screen. 

 
Cobb’s Angle 

Provides a function that can derive the inner angle of two lines of 

the patient image shown up on the screen. 

 
Remove Overlay 

Provides a function that deletes the last entered Overlay which is 

either Measure or Annotation appearing on the screen. 

However, if a certain Overlay has been selected then the selected 

Overlay is deleted. 

 

Remove All 

Overlay 

Provides a function that removes Measure or Annotation 

appearing on the screen.  

 

Annotation 

Toolbar 

Collection of functions that can add and delete arrows, 

free curves and character input to the patient image. 

Press this button to expand the detailed functions for use  

and press again to hide the detailed functions. 

 
Select 

Select the image in standard selection enabled status or  

choose the displayed Measure or Annotation. 

 
Arrow 

Provides a function that marks an arrow to the patient image 

shown on the screen. 

 
Line 

Provides a function that marks a signle line to the patient image 

shown on the screen. 

 
Poly Line 

Provides a function that marks a line same as the Line.  

Capable of drawing consecutive Line until prior to conclusion. 

 
Free Line 

Provides a function that enables marking of free curves to the 

patient image shown on the screen. 

 
Text 

Provides a function that marks texts to the patient images shown 

on the screen. 

 
Remove Overlay 

Provides a function that deletes the last entered Overlay which is 

either Measure or Annotation appearing on the screen. 

However, if a certain Overlay has been selected then the selected 

Overlay is deleted. 

 

Remove All 

Overlay 

Provides a function that can delete all Measure or Annotation 

displayed on the screen. 

 

Overlay Menu 
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Item Description 

Palette Setup pen color of the Overlay(Measure, Annotation) category. 

Thickness Setup pen thickness of the Overlay(Measure, Annotation) category. 

 

Patient List 

 

 

  

Item Description 

 
Refresh 

Executes the refresh function. 

When new image of the patient is scanned while image of the 

applicable patient is being analyzed then press the Refresh button  

to re-load the patient list. 

 Close 

Closes the applicable patient list. 

Closes image of the patient whose image is open in image view and 

removes information of the applicable patient from the patient list. 

 
Display Patient 

Name  

Displays name of the applicable patient. 

 Thumbnail List 

Image list of the applicable patient is displayed in the Thumbnail list. 

Double click on Thumbnail or Drag using the mouse and place in 

image view to display the applicable image.  

 

TIP 

Images by Modality type is listed for viewing in a pop-up menu which appears by 

clicking the right mouse button above the patient name. 

 

Type : [All]: View all,  

[PX]: View Panorama images only,  

[CT]: View CT images only, 

[DX]: View Cephalo images only,  

[IO]: View intraoral sensor images only,  

[OT]: View intraoral camera images only 
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3.1 Image Display 

Double click on ‘patient list’ from ‘Search’ tab or click the [Open] button, it will move to the ‘Image’ 

tab automatically. Opened patient is added to the patient list located below and scanned images 

are displayed as Thumbnail and the most recently scanned image is automatically displayed on the 

image view. 

Double click on Thumbnail of the desired image from the bottom ‘patient list’ or Drag using the 

mouse and place in image view then the applicable image is displayed. 

 

Image Display 

No. Figure Description 

1 

 

Select desired patient from the ‘patient list’ in 

the lower section. 

 

Notice – If desired patient is not opened 

then search in the ‘Search’ tab to 

open the applicable patient then 

the latest image of the applicable 

patient is automatically displayed. 

2 

 

Double click on the image thumbnail or Drag 

using the mouse on to the image view.  

 



SMARTDent  Image Management 

47 

3 

 

Image is displayed on the image view. 

 

 

3.2 Split Screen View 

Use the ‘Horizontal 2 split’ / ’Vertical 2 split’ screen to conveniently compare and analyze pre/post 

trement images and utilize ‘horizontal 3 split’ / ’vertical 3 split’ / ’4 split’ screen to shown multiple 

images on one screen for more efficient consult. 

 

Split Screen View 

No. Figure Description 

1 

 

Select by clicking the [Layout split] button from 

‘Top Menu’ on top. 

 

Tip – Basic view, horizontal 2 split, vertical 

2split, horizontal 3 split, vertical 3 split 

and 4 split mode are supported. 

2 

 

Confirm that screen has been splitted then 

select the patient whose image is intended for 

viewing. 
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3 

 

Double click on thumbnail of the image to be 

compared or Drag with the mouse and place 

on image view of the splitted screen.  

 

When comparing images of different patients, 

select applicable patients from the ‘patient list’ 

on bottom then select the images.  

 

(Double click or Drag&Drop) 

4 

 

Confirm that images are displayed on the 

splitted screen 

. 

 

Notice – Selected image view is indicated by 

an orange outer line in the split 

screen. 

 

 

3.3 Full Screen View 

Click the [Full Screen] button from ‘Top Menu’ or double click the mouse left button on image view 

to change full screen view. 

 

Full Screen View 

No. Figure Description 

1 

 

Select the desired image view then click the 

[Full Screen]  button from ‘Top Menu’ on top.  

 

Tip – Double click mouse in the applicable 

image view to change to full screen. 
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2 

 

Converted to full screen. 

 

 

3.4 Image Zoom / Shrink 

Use the ‘Image Zoom / Shrink’ function to adjust magnification of the image in accordance with 

the diagnostic goal. 

Images may be zoomed upto 10 times and shrunk down to 1/10. However, images cannot shrink 

smaller than the screen size. 

 

Image Zoom / Shrink 

No. Figure Description 

1 

 

Click the [Control Toolbar] button from ‘Tool 

bar’. 

2 

 

Click on the [Zoom] button. 
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3 

 

While left mouse button is clicked on top of 

the image, move toward right to zoom and left 

to shrink the image. 

 

Notice – Zoom upto 10 times the actual 

image and shrink down to 1/10 of 

the actual image however may not 

shrink smaller than the screen size. 

 

 

3.5 Image Rotate / Flip 

If image is entered in tilted condition or up, down/ left, right reversal is required then utilize the 

‘Image Rotate / Flip’ functions to edit. Image rotation and Flip information is not saved. 

 

Image Rotate / Flip 

No. Figure Description 

1 

 

Click the [Control Toolbar] button in ‘Tool bar’. 

2 

 

Click the [Rotate] button for image rotation. 

To reverse the image up and down / left to 

right, click the [Vertical Flip] / [Horizontal Flip] 

button.  
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3 

 

Confirm that image has rotated 90 degrees in 

clockwise direction. 

 

Notice – Position information is also changed 

during Image Rotate / Flip. 

 

 

3.6 Magnifying Glass 

Utilize the ‘Magnify’ function to enlarge certain section of the image for precision analysis and by 

activating the ‘Enhancement’ function boundaries of the anatomical structure becomes even more 

evident. 

 

Using the Magnifier 

No. Figure Description 

1 

 

Click the [Control Toolbar] button in ‘Tool bar’. 

2 

 

Click on the [Magnify] button. 
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3 

 

Magnified screen appears on the appropriate 

position by clicking the left mouse button on 

top of the image.   

When moving while left mouse button is 

pressed down then the magnified screen 

moves in conjunction. 

4 

 

To view certain areas in strengthened contrast 

ratio, click on [Enhancement] of the magnified 

screen.  

Enhanced regional image with maximized 

contrast ratio is displayed.  

 

 

3.7 Windowing Adjustment 

Use the Windowing adjustment function to optimize the image in further accurate diagnosis. 

‘Windowing Center’ adjustment is a function for adjusting brightness of the image and ‘Windowing 

Width’ adjustment is a function for adjusting contrast ratio of the image. When Windowing 

information is altered then the Windowing information in ‘Image Information’ of the image view on 

lower right is also changed. 

TIP 

After Windowing adjustment, click the [Save] button on upper right section to save 

the modified Windowing information allowing checking of the image in same 

condition continuously. 

When closing the program after Windowing adjustment, a message requesting save 

status of the modified information appears.   
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Windowing Adjustment 

No. Figure Description 

1 

 

Click the [Process Toolbar] button in ‘Tool bar’. 

2 

 

Click the [Windowing] button. 

3 

 

From above the image while left mouse button 

is pressed down, move the mouse up and 

down to change the ‘Window Center’ value.  

To brighten the image, move the mouse 

upward (reduce Window Center value) and 

downward (increase Window Center value) to 

darken the image. 

4 

 

From above the image while left mouse button 

is pressed down, move the mouse left and 

right to change the value of the ‘Window 

Width’.  

 

To widen the contrast region, move mouse to 

the right (increase Window Width value) and to 

narrow the contrast region, move mouse to the 

left (reduce Window Width value). 
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3.8 Image Median / Sharpen Display 

‘Median’ reduce noise of the image but anatomical structure may become ambiguous. ‘Sharpen’ 

makes the anatomical structures clearly but noise of the image is increased. 

NOTICE Image information modified due to ‘Median’, ‘Sharpen’ functions are not saved. 

 

Image Median / Sharpen Display 

No. Figure Description 

1 

 

Click the [Process Toolbar] button in ‘Tool bar’. 

2 

 

To display a smoother image, click the [Median] 

button.  

Continue to click the button then the 

overlapped effect is applied.  

Click the [Initialize] button to cancel 

immediately. 

3 

 

To display a sharpen image, click the [Sharpen] 

button.  

Continue to click the button then the 

overlapped effect is applied. 

Click the [Initialize] button to cancel 

immediately. 
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3.9 Length Measurement 

Enter two points to measure the length between two points. Select length measurement with [Select] 

mode, it enables start and end point to modify the length measurement. 

TIP 
When closing the program, a message can be displayed for saving the measurement 

information. 

 

Length Measurement 

No. Figure Description 

1 

 

Click the [Measure Toolbar] button in ‘Tool bar’. 

2 

 

Click the [Length] button. 

3 

 

From above the image, click the starting point 

and ending point in order of the area required 

for measurement then the length is displayed. 

Unit of the length is in ‘mm’ which represents 

the actual measurement unit. 

Tip - Click the [Select] button to convert to 

mouse mode then select the appropriate 

Overlay to move its position or modify 

starting and ending points.  
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Length Continuity Measurement  

No. Figure Description 

1 

 

Click the [Measure Toolbar] button in ‘Tool bar’. 

2 

 

Click the [Multi Length] button. 

3  

From above the image, click the starting point 

and ending point of the area required for 

measuring in order to measure the length. 

Continue to click then the end point is 

recognized as the starting point for consecutive 

length measurement and double click the 

mouse to conclude the length measurement. 

Unit of the length is in ‘mm’ which represents 

the actual measurement unit.   

 

Tip – Click the [Select] button to convert to 

mouse mode then select the 

appropriate Overlay to move position 

or modify starting, mean and end 

points. 
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3.10 Angle Measurement 

‘Angle’ is a function that measures internal angle (external angle) of 2 segments composed of 3 

points and ‘Cobb’s Angle’ is a function that measures internal angle (external angle) of 2 segments 

composed of 4 points. 

 

TIP 

After angle measurement, click the [Save] button on upper right side to save it. 

When closing the program following angle measurement, a message requesting save 

status of the modified information appears.  

 

Random Angle Measurement 

No. Figure Description 

1 

 

Click the [Measure Toolbar] button in ‘Tool bar’. 

2 

 

Click the [Angle] button. 

3 

 

Click the start, mid-point and end point, angle 

is displayed and if you double click, angle 

measurement will be finished. Angle is shown 

as internal angle (external angle) and unit is in 

‘Degree’. 
 

Tip – Click the [Select] button to convert to 

mouse mode then select appropriate Overlay 

to move position or modify points. 
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Cobb’s Angle Measurement 

No. Figure Description 

1 

 

Click the [Measure Toolbar] in ‘Tool bar’. 

2 

 

Click the [Cobb’s Angle] button. 

3 

 

From above the image, click the starting and 

ending points sequentially in the area required 

for measurement and draw 2 lines (total of 4 

points) then the Cobb’s Angle will appear. 

Displayed angles are internal angle (external 

angle) and units are in ‘Degree’ representing 

the actual measurement angles. 

 

Tip – Click the [Select] button to convert to 

mouse mode then select the 

appropriate Overlay to move position 

or modify starting, mean and end 

points. 

 

 

3.11 Implant Simulation 

‘Implant’ is a simulation function to select optimal implant for patients. SMARTDent supports an 
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image based implant simulation function for further efficient consultation. It provides various 

implant library and you can use user implant function.  

TIP 

Enter implant then click the [Save] button on upper right side to save it. 

When closing the program following implant simulation, a message requesting to 

confirm save status of the modified information appears. 

 

Insert Implant 

No. Figure Description 

1 

 

Click the [Measure Toolbar] button in ‘Tool bar’. 

2 

 

Click the [Implant] button. 

3 

 

‘Select Implant’ window appears on bottom  

of the screen. 
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4 

 

Click on the desired Implant for selection. 

 

Tip – Select length and diameter in Size to 

view desired sizes in array.. 

5 

 

Click left mouse button on the position where 

Implant insertion is required then the Implant 

appears over the image.  

6 

 

Click left mouse button over the Implant and 

drag, Implant position will be changed. 

Click the red rectangle of the upper left side of 

Implant then move the mouse to rotate the 

Implant. 

 

 

User Implant Insertion 

No. Figure Description 

1 

 

Click the [Measure Toolbar] button in ‘Tool bar’. 
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2 

 

Click the [Implant] button. 

3 

 

‘Select Implant’ window appear on bottom  

of the screen. 

4 

 

Click the [Custom] button. 

5 

 

Click on the desired Implant shape for 

selection. 
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6 

 

Setup desired length and diameter. 

7 

 

Click the left mouse button on the position 

where Implant insertion is desired then the 

Impant appears over the image. 

8 

 

Click the left mouse button over the Implant 

and drag, Implant position will be changed.. 

Click the red rectangle on upper left side of the 

Implant then move the mouse to ratote the 

Implant. 

 

Notice SMARTDent supports implant color setting function. (Configuration  Implant Setting) 
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3.12 Free Curve Drawing 

Use the ‘Free Line’ function to record diagnostic information in the images and efficient consult 

with the patients. 

TIP 

After drawing free curve, click [Save] button on upper right side to save it. 

When you close the program after drawing free curve, a message will be displayed for 

requesting save it or not. 

 

Free Curve Drawing 

No. Figure Description 

1 

 

Click the [Annotation Toolbar] button in  

‘Tool bar’.  

2 

 

Click the [Free Line] button. 

3 

 

From above the image while left mouse button 

is pressed down, draw a desired shape then the 

free curve is drawn on the screen. 

 

Tip – Click the [Select] button to convert to 

mouse mode then select the appropriate 

Overlay to move position. 
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3.13 Insert Text 

Use the ‘Text’ function to record diagnostic information of the image and patient complains for 

treatment. 

TIP 

After entering texts, click the [Save] button on upper right side to save it. 

When closing the program following text input, a message requesting to confirm save 

status of the modified information appears.  

 

Insert Text 

No. Figure Description 

1 

 

Click the [Annotation Toolbar] button  

in ‘Tool bar’. 

2 

 

Click the [Text] button. 

3 

 

Click the left mouse button on the position 

where text insert is desired then a window 

enabling text entry appears thereafter enter 

text then press the [Enter] key to complete  

the entry. 

 

Tip – Click the [Select] button to select the 

item and double click it to modify text. 
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3.14 Remove Overlay  

‘Overlay’ refers to additional categories entered on to images such as length, angle measurement 

information, implant, free curves and texts. 

‘Overlay’ may be removed one at a time or all entered information as a singular event. 

 

 

Remove Single Overlay  

No. Figure Description 

1 

 

Click [Measure Toolbar] button or  

[Annotation Toolbar] button in ‘Tool Bar’. 

2 

 

Click the [Select] button. 

3 

 

Click the left mouse button over the deletion 

desired Overlay to select the appropriate 

Overlay. 
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4 

 

Click the [Remove Overlay] button to delete  

the applicable Overlay. 

 

 

Remove All Overlay  

No. Figure Description 

1 

 

Click [Measure Toolbar] button or  

[Annotation Toolbar] button in ‘Tool Bar’. 

2 

 

Click the [Initialize Overlay] button. 

3 

 

Click [Yes] in the delete confirm message 

window. 
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4 

 

All Overlays existing over the image is deleted. 

 

 

3.15 Saving Image Changes 

When image changes are saved then the information is stored in the server allowing continuous 

use of the applicable information from any PC included in the network. 

Manual Save 

No. Figure Description 

1 

 

The [Save] button of the ‘Top Menu’ on top 

becomes active when Windowing value is 

changed or Measure, Annotation insert,  

change or delete is achieved.  

 

2 

 

By saving changes by clicking the [Save] button 

then the [Save] becomes inactive and when 

image is closed then opened again, the image 

displayed is in same condition as the last save. 
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Save while Closing 

No. Figure Description 

1 

 

When closing the patient list of the image 

where changes are made or ending the 

program, a message window requesting 

whether to save the changes will appear. 

2 

 

Click [Yes] to save the changes and when 

applicable image is re-opened, the image 

displayed is equivocal to the present condition. 

Click [No] then the changes made are not 

saved and when applicable image is re-opened, 

the image displayed is equivalent to the last 

saved condition prior to making changes. 

 

 

3.16 Image Print 

Images may be printed using either the ‘General Printer’ or ‘DICOM Printer’. 

 

General Printing 

No. Figure Description 

1 

 

Display print desired image on image view 

then click the [Print] button from the ‘Top 

Menu] on top of the screen. 
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2 

 

‘Print Image’ pop-up window appears. 

3 

 

Select ‘General Printer’ from the ‘Printer’ list. 

4 

 

Select only the images to be printed from 

the ’Thumbnail’ list on bottom right side  

then setup the print properties.   

 

Tip – Print properties: paper, print direction, 

Layout, image enlargement ratio, 

header print status, Overlay print status 

5 

 

Click the [Print] button to proceed printing. 

 

DICOM Printing 

No. Figure Description 

1 

 

Click the [Configuration] button on upper right 

side of the program and confirm that desired 

printer item is included in the ‘DICOM Print 

SCP’ list.   

 

Notice –Click [New] to add item and 

[Modify] to edit the setting value. 
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2 

 

Display the print desired image on the image 

view then click the [Print] button in ‘Top 

Menu‘ on top of the screen. 

3 

 

Print pop-up window appears. 

4 

 

Select ‘DICOM Printer’ from the ‘Printer’ list. 

4 

 

Select only the images intended for printing 

from the ‘Thumbnail’ list on bottom right  

then setup the print properties.  

 

Tip – Print properties: Film Size, Print 

Direction, Medium Type, 

Magnification, Print Priority, Layout, 

Image Enlargement Ratio,  

Header print status 

5 

 

Click the [Print] button to proceed printing. 
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Multiple Image Print 

No. Figure Description 

1 

 

Make multiple image view as the figure and 

click the [Print] button in the top menu. 

2 

 

Print pop-up window will appear. 

Refer to [General Print] or [DICOM Print] and 

proceed to image print.  

 

Notice – For Multiple Image Print, Thumbnail 

and Layout function do not offer.  

 

 

3.17 List Image by Modality  

In case of numerous images exist for the patient, you can select specific modality for sorting images. 

 

List Image by Modality  

No. Figure Description 

1 

 

Click the right mouse button on the patient 

name list. 
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2 

 

Select the ‘Modality’ what you want to view. 

3 

 

Only selected modality images are displayed. 

 

 

3.18 Delete Image 

Use the ‘Reject’ function to delete images. ‘Reject’ is a function that prohibits search of the applicable 

image from the server. When ‘Reject’ image undergoes ‘Confirm’ in RAYSCAN program then the 

image is searched again from SMARTDent. 

 

Delete Image 

No. Figure Description 

1 

 

Click the [Modality] button on upper right side 

of the image thumbnail from the lower  

‘Patient List’. 
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2 

 

Select ‘Reject’ menu from the pop-up menu  

to make a selection.  

 

3 

 

Check the image(s) you want to delete then 

click the [Delete] button.  

If you want to delete all images click the 

[Select All] button. 

4 

 

Note that selected image(s) has been removed. 

 

Tip – The applicable image is not 

permanently deleted rather converted 

to Reject status therefore may be 

converted back to ‘Confirm’ condition 

from the RayScan program. 
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3.19 3D Viewer Setting 

It supports 3D viewer setting for viewing the dental CBCT images. 

Xelis Link 

No. Figure Description 

1 

 

Click the [Configuration] button on upper right 

section of the program and confirm that Xelis 

program path in ‘3D Viewer’ list is setup 

correctly. 

 

Notice – If applicable item does not exist  

or setting is incorrect then click  

the [Browser] button and setup  

the Xelis program path. 

2 

 

Click the [Modality] button on upper right side 

of the image thumbnail from the lower patient 

list.  

3 

 

Click ‘3D Viewer’ menu from the pop-up menu 

to select.. 

 

Notice – ‘3D Viewer’ menu is supported  

only for ‘CT’ images. 

4 

 

Confirm execution of Xelis program and 

transfer of applicable patient and image 

information then click the [OK] button.   
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5 

 

Proceed image analysis.  

 

 

Save Xelis project 

No. Figure Description 

1 

 

After image analysis the analysis CT image can 

be saved To save project file click  icon 

from output on central part of the left.  

2 

 

Write Operator, Series No. and Description 

section then click [OK] button to save it.   

 

Notice 

When select ‘3D viewer’ from SMARTDent, run Xelis and then quit 

SMARTDent or change patients  the data won’t be saved in SMARTDent even 

if save in Xelis.. 
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Bring Xelis project 

No. Figure Description 

1 

 

Click [Modality] button from the upper right 

corner of image thumbnail on the list at the 

bottom of the patient  

 

2 

 

Select to click ‘3D viewer’ from the pop-up 

menu  

 

Notice – ‘3D viewer’ offer only for CT image  

3 

 

Select project tab after run Xelis program the 

saved project file is appeared on current image, 

select project file that you want to bring and 

click the [OK] button. 

4 

 

Applying project and bring up the image. 
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Xelis Capture  

No. Figure Description 

1 

 

Select image that you want to capture by 

clicking  button on the central portion of 

the left or click [FullScreen] button on the 

lower part of the left   

 

Notice – When occur flashing effect,  normal 

capture processing is being. 

2 

 

Return to SMARTDent click  button the 

captured images are shown  

 

Notice 

When select ‘3D viewer’ from SMARTDent, run Xelis and then quit 

SMARTDent or change patients  the data won’t be saved in SMARTDent 

even if save in Xelis.. 
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3.20 Pano-FMX 

You can create IO sensor image to edit PX(Panorama) images. 

 

Use Pano-FMX Function 

No. Figure Description 

1 

 

Check [Use Pano-FMX] in Intraloral section 

from configuration tab.  

2 

 

Click [Modality] button on the top of image 

thumbnail from patient list. 

3 

 

Select ‘Use Pano-FMX’ from pop-up menu. 

 

Notice – ‘Use Pano-FMX’ menu only offer for 

‘Panorama(PX)’ images. 

4 

 

You can see that the Edit image window 

appeared. 
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5 

 

Select FMX mode you want. 

6 

 

Set cutting position by moving Smile Line. 

7 

 

If you want a more detailed editing click the 

[Modify] button.  

8 

 

Unchecked unnecessary images from FMX view 

on the upper right corner. 

9 

 

Select image for a more detailed editing and 

Perform the movement and rotation of images.  

10 

 

Click the [Confirm]  button when the editing is 

done.  
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11 

 

After confirming the oral sensor image click the 

[Save] button. 

12 

 

Confirm the saved images. 
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FMX 

4 
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4 FMX 
 

In FMX, intraoral sensor and intraoral camera acquisition and view functions are available.  

SMARTDent manages the images based on FMX for easier search of the intraoral snesor and 

intraoral camera images and management of position information. In case of the deciduous tooth, 

FMX 12 View is used and if only permanent teeth or permanent teeth accompanied by deciduous 

teeth then FMX 18 View is used. 

NOTICE 

FMX is an acronym for Full Mouth X-ray and designed for efficient management of  

the complete arch intraoral radiation images and used widely around the world. 

Used to FMX is used in intraoral camera images for managing of position information. 

 

‘FMX’ tab screen composition and details of each item are as follows. 

 

Figure 9.  'FMX' Tab screen 

 

Top Menu 

FMX View 
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Top Menu 

 

Item Description 

 Patient List 

Displays the currently opened patient. Patient change 

is also available. 

Changing the patient also changes contents of the 

FMX View. 

 
IO Sensor Acq 

Click to convert to the intraoral sensor acquisition 

screen  

of the current selected patient. 

 
IO Camera Acq 

Click to convert to intraoral camera acquisition screen 

of  

the current selected patient. 

 
IO Sensor View 

Displays intraoral sensor images of the current selected 

patient. 

Most recent image by each of the position is 

displayed. 

 
IO Camera View 

Displays intraoral camera images of the current 

selected patient. 

Most recent image by each of the position is 

displayed. 

 
IO Multi View 

Displays intraoral sensor images and intraoral camera 

images of the current selected patient simultaneously. 

Most recent images by each of the position are 

displayed.  

 

IO Sensor/Pano 

View 

Displays intraoral sensor image and panorama image 

of  

the current selected patient simultaneously.  

Each image shown is the most recent image. 

 
FullScreen View selected image in full screen. 

 FMX View Mode Converts currently displayed FMX View Layout 

 
Tooth History 

Enumerates past images in the same position as  

the currently selected images for viewing. 

Images selected from the printed image list replace 

the applicable position of the FMX View. 

 
Image Compare 

You can see by comparing the image of the same 

location as the image is currently selected..  
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NOTICE 
When FMX 12 / 18 View conversion, the deciduous teeth are not seen in FMX 18 View 

and vice versa permanent teeth are not seen in the FMX 12 View.  

 

FMX View 

Changes the FMX Layout according to the mode selected in ‘Top Menu’ and displays the image 

coinciding with each position. As standard, latest image by each position is displayed and by 

clicking the [History] button in ‘Top Menu’, select and view the previous image of the applicable 

position. 

 

 

4.1 Image Display 

Patients opened through the Search tab amatically added to the list of patients  

Select patient from the list latest images are listed on FMX view  

 

Display patient’s image 

No. Figure Description 

1 

 

Select patient at the top of the patients list. 

 

Notice – Only the patients opend by double 

click from ‘patient list’ or click 

‘Open’ button in Search tab are 

displayed  
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2 

 

Latest images of patient is displayed on FMX 

view. 

 

 

Display patient images taken by date 

No. Figure Description 

1 

 

Click the date list at the top of the FMX view 

and select acquisition date 

2 

 

Display images taken by selection date on FMX 

view 
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Display image history by location  

No. Figure Description 

1 

 

From FMX view, select location you want to 

display image history. 

2 

 

Click [Image History] button at the top or the 

number that shows history number at the top 

right of selection image  

3 

 

Select image that you want to display.. 

4 

 

You can see the image you choose is displayed  
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Compare images 

No. Figure Description 

1 

 

Select tooth position that you want to compare 

from FMX view. 

2 

 

Click [image compare] button at the right top. 

3 

 

The window for comparing image will appear 

4 

 

Drag image from humbnail at the buttom 

intothe image view. 



SMARTDent  FMX 

88 

5 

 

Compare two displayed images 

 

 

4.2 Image Print 

Print images displayed on FMX view. 

 

Print FMX view image 

No. Figure Description 

1 

 

Display the images you want to print and click 

[print] button at the top of the menu. 

2 

 

‘Print’ pop-up window appear. 

Refer to 3.16 [Image print] 또는 [DICOM print] 

section proceed image print.  

Notice – When print FMX images Thumbnail 

and Layout functions are not offered. 
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4.3 Intraoral Sensor Acquisition 

Select ‘Patient List’ from the ‘Search’ tab screen then click the [IO X-Ray acq.] button on bottom or 

click the [IO X-Ray Acqusition] button from the ‘FMX’ tab screen to convert to intraoral sensor 

acquisition screen. 

 

Prior to the first time intraoral sensor acquisition, ‘intraoral sensor setup’ and ‘intraoral sensor 

calibration’ must be performed for proper capturing. 

Intraoral sensor acquisition screen composition and contents of each item are as follows. 

 

 

Figure 10.  Intraoral Sensor Acquisition Screen 

 

IO Sensor Control Button 

     

Item Description 

 
Configuration Modify setting values required for intraoral sensor acquisition. 

 

Patient Information 
IO Sensor Control Button 

FMX View 

Thumbnail View 

Image Preview 
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Ready / Cancel 

Imaging Ready / Cancel button and as standard, [Ready] is active. 

Click the [Ready] button to prepare for acquisition and when 

acquisition is ready then the button changes to [Cancel]. 

 Confirm Saves the scanned image and closes the acquisition window. 

 

Close / Reject 

When there is no scanned image the [Close] button becomes 

active to execute the window close function. 

When there is a scanned image then [Reject] button becomes 

active and save image and acquisition window are closed.  

 4 FMX View screen is displayed for 4 

 7 FMX View screen is displayed for 7 

 12 FMX View screen is displayed for the deciduous teeth (12). 

 18 FMX View screen is displayed for the permanent teeth (18).  

 

Sequential 

As the ‘Sequential Acquisition’ button, after acquisition the 

number selected in FMX View changes automatically to the next 

number.  

 
Stationary 

As the ‘Stationary Acquisition’ button, enables continuous 

acquisition in selected FMX View. 

 

TIP 

Images shot in FMX 12/18 View are displayed all on bottom as thumbnail.  

Regardless of whether the images are shot in FMX 12 View then converted and  

saved in FMX 18 View, the images shot in FMX 12 View are still saved. 

To move the images shot in FMX 12 View to FMX 18 View, convert to FMX 18 View  

then Drag the image thumbnail on bottom with the mouse and drop in the desired 

position. 

 

TIP 

Image information is saved in the server during Reject, but cannot be viewed  

in SMARTDent. 

To display the Rejected image in SMARTDent for viewing, change status to ‘Confirm’ 

in ‘Review’ tab of the RayScan. 
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IO acquisition when uninstalled RAY IO  

For IO acquisition you must install RAY IO. 

If RAY IO is not installed, the warning message appears when click IO acquisition button.  

 

 

Figure 11.  Warning message  

 

 

 

Sensor connection 

Outputs a message that shows current Intraoral sensor connection status. 

( All for four types – Device enable / disable, ready to shoot, Not ready to shoot due to 

memory leak) 

 

Image Description 

 

There is no connected device. 
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The device is connected.  

 

Prepare for acquisition with the device. 

 

Image Preview 

 

Item Description 

 Tooth Number Displays tooth number of the scanned image. 

 Large Image Supports enlarged view of the scanned image. 

 
Left Rotate 

Rotates the scanned image 90 degrees to the left. 

 
Right Rotate 

Rotates the scanned image 90 degrees to the right. 

 
Prev Image 

Displays the previous image scanned in the selected FMX View 

position. 

 
Image Count 

Displays the ‘number of the image currently displayed / total image 

count’ of the selected FMX View position.  

 
Next Image 

Displays the next image scanned in the selected FMX View position. 

 
Filter Setting 

Display a Filter Setting Window. 

 

Tooth Number 

Large Image 

Bottom 
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Item Description 

Processing Type Set Image processing type.  

Sharpen Set sharpen value.  

Width Set Window Width value.  

Center Set Window Center value. 

Initialize Initialize all values.  

Apply Save and apply setting values.  
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FMX View 

   

Item Description 

Tooth Number Displays the tooth number of the position selected in FMX View. 

Image Displays the scanned image of the position selected in FMX View. 

 

 

Thumbnail View 

 

 

Item Description 

Tooth Number Displays the tooth number of the scanned image. 

Delete Deletes the scanned image. 

Thumbnail Image Displays the thumbnail image of the scanned image. 

 

  

Tooth Number Delete 

Thumbnail Image 

Tooth Number 

Image 
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4.3.1 Intraoral Sensor Calibration 

Calibration is required prior to the initial acquisition for optimization of detector. This function is 

not for user, please do not put to use by yourself. 

Click the [Calibration] button on lower part of the intraoral sensor setting screen then the pop-up 

window for calibration will be displayed.  

CAUTION Abnormal images may be obtained if user performs Calibration at random. 

 

 

4.3.2 Intraoral Sensor Setting 

Setup sensor characteristic values of [Gain] / [Trigger Level] / and [Filter Level] through the 

intraoral sensor setting function.  

If intraoral sensor image acquisition fails or problem exists in the image quality, please contact the 

customer service center. 

 

CAUTION 
Prohibit arbitrary modification of values for [Gain] / [Trigger Level] / and [Filter Level].  

When values are modified, image may not be obtained or degrade the image quality. 

 

   

Figure 12.  Intraoral Sensor Setting Screen 

 

 

 

Header 

Contents 

Bottom 
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Contents 

Item Description 

Device List Displays devices connected to the present PC. 

Integration Time Settings for time used in case of the standard.  

PT mode On/off PT mode. 

Edge filling Set the type of imamge edge, 

 

Bottom 

Item Description 

Calibration Displays devices connected to the present PC. 

Exp. guide Shows Exposure Time Guide window.  

Save Save setting. 

Cancel Cencel to set Configuration 

 

Calibration screen composition and contents of each item are as follows. 

  

Figure 13.  Intraoral Sensor Calibration screen 

Contents 

Item Description 

Message 
Number of Sample imaging count is displayed.  

For Calibration, Sample imaging of #16 is required. 

 

Bottom 

Item Description 

Connect Connect to device and proceed to Calibration imaging. 

 

 

 

Header 

Contents 

Bottom 
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Cancel Closes the window. 

 

NOTICE 
The installer performs calibration during installation therefore the user is not required 

to perform additional calibration. 

 

 

4.3.3 Exposure Time 

  

 

Contents 

Item Description 

Contents If enter the exposure time of conntected device, calculate the real 

exposure time for the teeth acquisition 

 

Bottom 

Item Description 

Save  Save and apply the exposure time.  

Cancel Cancel to set the exposure time 

 

 

 

 

 

Header 

 

Contents  

Bottom 
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4.3.4 Intraoral Sensor Image Acquisition 

Intraoral sensor acquisition provides the ‘sequential acquisition mode’ which after capturing moves 

to the next FMX View position and ‘stationary acquisition mode’ which allows acquiring multiple 

images at a fixed position.   

Images rotate automatically depending on the FMX View position. If rotation information is incorrect 

then from ‘Image Preview’ click [Left Rotate] or the [Right Rotate] button to rotate the image or 

click the right mouse button above the applicable image of the FMX View then the image rotates 

by 90 degrees in clockwise direction.  

Image rotate and position information is not available once image is saved by clicking the [Confirm] 

or [Reject] button therefore perform image rotate, position move and image delete prior to closing 

the window.  

 

Sequential Acquisition Mode 

No. Figure Description 

1 

 

Select device type to RIOSensor_RIS500 from 

Intraoral tab.  

2 

 

Select the patient undergoing capturing then 

click on the [IO X-Ray Acqusition] button. 

 

Tip – Same function is performed by 

selecting the patient undergoing 

capturing from ‘patient list’ of the 

‘Search’ tab then clicking the [IO X-Ray 

acq.] button on the bottom. 
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3 

  

When selected patient information appears, 

click [OK] to proceed to capturing. 

By clicking the [Cancel] button, end capturing 

and return to the ‘FMX’ tab. 

 

Caution – If device is not connected then 

cannot find device message 

appears and returns to  

the ‘FMX’ tab. 

4 

 

Click the [Sequential] button to proceed to 

sequential acquisition mode. 

5 

 

When preparation for capturing is completed, 

click on the [Ready] button. 

6 

 

When capturing is completed then the image  

is displayed in 3 locations; ‘FMX View’,  

‘Image Preview’, ‘Thumbnail Image’.  

Drag the completed image to move to 

alternate position, rotate or delete. 

Tip – In no relation to imaging preparation, 

FMX 4 / 7 /12 / 18 View and 

Sequential / Stationary conversion are 

available. 
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7 

 

When capturing is completed, click on the 

[Confirm] button to save image and close 

 the acquisition window. 

If image save is not required then click on  

the [Reject] button to close the window. 
 

Tip – Image is not displayed on FMX screen 

by clicking the [Reject] button.  

For display convert to ‘Confirm’ status 

in ‘Review’ tab of the RayScan. 

8 

 

Acquired image is displayed in FMX View. 

 

Stationary Acquisition Mode 

No. Figure Description 

1 

 

Select device type to RIOSensor_RIS500 from 

Intraoral tab.  

2 

 

Select the patient undergoing capturing then 

click on the [IO X-Ray Acqusition] button. 

 

Tip – Same function is performed by 

selecting the patient undergoing 

capturing from ‘patient list’ of the 

‘Search’ tab then clicking the [IO X-Ray 

acq.] button on the bottom. 
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3 

 

When information of the selected patient 

appears, click [OK] to continue capturing. 

By clicking the [Cancel] button,  

end capturing and return to ‘FMX’ tab. 

 

Caution – If device is not connected then 

cannot find device message 

appears and returns to  

the ‘FMX’ tab. 

4 

 

Click on the [Stationary] button to proceed to 

the stationary acquisition mode. 

5 

 

When preparation for capturing is ready  

then select the capturing position and click  

the [Ready] button. 

6 

 

When capturing is completed, the image is 

displayed in 3 separate locations; ‘FMX View’, 

‘Image Preview’ and ‘Thumbnail Image’. 

 

Tip - In no relation to capturing preparation, 

FMX 4 / 7 / 12 / 18 View and 

Sequential / Stationary conversion are 

available. 

7 

 

When capturing is repeated then the image is 

overlapped in the same position. 

Note that image thumbnail is added and the 

image count on the bottom of ‘Image Preview’ 

increases.   

Completed acquiring images may be moved  

to an alternate position via Drag, rotate or 

deleted. 
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8 

 

When capturing is completed press the 

[Confirm] button to save the image and  

close the capturing window. 

If image is unused then click the [Reject] 

button and close the window. 

9 

 

Acquired image is displayed in FMX View. 

 

 

Rotate Image 

Before saving the acquired images, please rotate the images properly. 

No. Figure Description 

1 

 

Click [Right Rotate] or [Left Rotate] button  

on bottom of ‘Image Preview’ of the scanned 

image.  

 

Tip – From over the applicable image of  

the FMX View, click the right mouse 

button to rotate the image 90 degrees 

to the right. 

2 

 

Image is rotated. 

 

 



SMARTDent  FMX 

103 

Move Image Position 

Before saving the acquired images, please move images to proper position. 

No. Figure Description 

1 

 

Click the left mouse button above the image 

required to be moved and Drag then drop  

the image at desired position.  

2 

 

Image is rotated automatically according to 

rotate information of the applicable position. 

 

 

Delete Image 

Before saving the acquired images, please delete the images which you do not want to save. 

No. Figure Description 

1 

 

Click the [Delete] button upper right part of 

thumbnail.  

 

2 

 

When delete confirm message window appears 

click [Yes]. 

If deletion is not desired then click [No]. 

 

Caution – Deleted images cannot be 

restored. 
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3 

 

Applicable image is deleted from the thumbnail 

list. 
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4.4 RIOScan Acquisition 

Select ‘Patient List’ from the ‘Search’ tab screen then click the [IO X-Ray acq.] button on bottom or 

click the [IO X-Ray Acqusition] button from the ‘FMX’ tab screen to convert to RIOScan screen. 

RIOScan acquisition screen composition and contents of each item are as follows. 

 

 

 

Figure 14.  RIOScan Acquisition Screen 

 

 

IO Sensor Control Button 

     

 

Item Description 

 
Configuration Modify setting IP Address list for RIOScan. 

 

Patient Information RIOScan Control Button 

FMX View 

Thumbnail View 

Image Preview 
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 Scan Ready for RIOScan Scan Mode. 

 Browse Bring the images from RIOScanno 

 Confirm Saves the scanned image and closes the acquisition window. 

 

Close / Reject 

When there is no scanned image the [Close] button becomes 

active to execute the window close function. 

When there is a scanned image then [Reject] button becomes 

active and save image and acquisition window are closed.  

 4 FMX View screen is displayed for 4 

 7 FMX View screen is displayed for 7 

 12 FMX View screen is displayed for the deciduous teeth (12). 

 18 FMX View screen is displayed for the permanent teeth (18).  

 

Sequential 

As the ‘Sequential Acquisition’ button, after acquisition the 

number selected in FMX View changes automatically to the next 

number.  

 
Stationary 

As the ‘Stationary Acquisition’ button, enables continuous 

acquisition in selected FMX View. 

 

TIP 

Images shot in FMX 12/18 View are displayed all on bottom as thumbnail.  

Regardless of whether the images are shot in FMX 12 View then converted and  

saved in FMX 18 View, the images shot in FMX 12 View are still saved. 

To move the images shot in FMX 12 View to FMX 18 View, convert to FMX 18 View  

then Drag the image thumbnail on bottom with the mouse and drop in the desired 

position. 

 

TIP 

Image information is saved in the server during Reject, but cannot be viewed  

in SMARTDent. 

To display the Rejected image in SMARTDent for viewing, change status to ‘Confirm’ 

in ‘Review’ tab of the RayScan. 

 

 

IO acquisition when uninstalled RAY IO  

For IO acquisition you must install RAY IO. 

If RAY IO is not installed, the warning message appears when click IO acquisition button.  
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Figure 1.  Warning message  

 

 

Image Preview 

 

 

Item Description 

 Tooth Number Displays tooth number of the scanned image. 

Tooth Number 

Large Image 

Bottom 
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 Large Image Supports enlarged view of the scanned image. 

 
Left Rotate 

Rotates the scanned image 90 degrees to the left. 

 
Right Rotate 

Rotates the scanned image 90 degrees to the right. 

 
Prev Image 

Displays the previous image scanned in the selected FMX View 

position. 

 
Image Count 

Displays the ‘number of the image currently displayed / total image 

count’ of the selected FMX View position.  

 
Next Image 

Displays the next image scanned in the selected FMX View position. 

 
Filter Setting 

Display a Filter Setting Window. 

 

 

 

 

 

Item Description 

Processing Type Set Image processing type.  

Sharpen Set sharpen value.  
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Width Set Window Width value.  

Center Set Window Center value. 

Histogram 

Shows image histogram 

The color bar below the histogram is for image exposure. 

If image exposure is ideal the color bar will be displayed in white. 

Closer to blue means under exposure, closer to red means over 

exposure. 

Initialize Initialize all values.  

Apply Save and apply setting values.  

 

FMX View 

   

Item Description 

Tooth Number Displays the tooth number of the position selected in FMX View. 

Image Displays the scanned image of the position selected in FMX View. 

 

 

  

Tooth Number 

Image 
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Thumbnail View 

 

 

Item Description 

Tooth Number Displays the tooth number of the scanned image. 

Delete Deletes the scanned image. 

Thumbnail Image Displays the thumbnail image of the scanned image. 

 

4.4.1 RIOScan IP Address Setting 

Before using the RIOScan, you should setup IP Address for RIOScan. 

When click [OK] button, IP Address will be saved automatically. 

     

그림 3 RIOScan IP setting screen 

 

  

 

 

 

Header 

Contents 

Bottom 

Tooth Number Delete 

Thumbnail Image 
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Contents 

Item Description 

Name Name for IP Address  

IP IP Address 

New Add new IP Address.  

Modify Modify the IP Address. 

Delete Delete the IP Address.  

 

Bottom 

Item Description 

OK Close the IP Address List Setting Window 

 

 

4.4.2 RIOScan Image Acquisition 

RIOScan Scan provides the ‘sequential acquisition mode’ which after capturing moves to the next 

FMX View position and ‘stationary acquisition mode’ which allows acquiring multiple images at a 

fixed position.   

Images rotate automatically depending on the FMX View position. If rotation information is incorrect 

then from ‘Image Preview’ click [Left Rotate] or the [Right Rotate] button to rotate the image or 

click the right mouse button above the applicable image of the FMX View then the image rotates 

by 90 degrees in clockwise direction.  

Image rotate and position information is not available once image is saved by clicking the [Confirm] 

or [Reject] button therefore perform image rotate, position move and image delete prior to closing 

the window.  
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Sequential Scan Mode 

No. Figure Description 

1 

 

Select device type to RIOScan_RPS500 from 

Intraoral tab.  

2 

 

Select the patient undergoing capturing then 

click on the [IO X-Ray Acqusition] button. 

 

Tip – Same function is performed by 

selecting the patient undergoing 

capturing from ‘patient list’ of the 

‘Search’ tab then clicking the [IO X-Ray 

acq.] button on the bottom. 

3 

 

When selected patient information appears, 

click [OK] to proceed to capturing. 

By clicking the [Cancel] button, end capturing 

and return to the ‘FMX’ tab. 

4 

 

Click the [Sequential] button to proceed to 

sequential acquisition mode. 
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5 

 

When preparation for scan is completed, click 

on the [Scan] button. 

6 

 

When capturing is completed then the image  

is displayed in 3 locations; ‘FMX View’,  

‘Image Preview’, ‘Thumbnail Image’.  

Drag the completed image to move to 

alternate position, rotate or delete. 

Tip – In no relation to imaging preparation, 

FMX 4 / 7 / 12 / 18 View and 

Sequential / Stationary conversion are 

available. 

7 

 

When scanning is completed, click on the 

[Confirm] button to save image and close 

 the acquisition window. 

If image save is not required then click on  

the [Reject] button to close the window. 
 

Tip – Image is not displayed on FMX screen 

by clicking the [Reject] button.  

For display convert to ‘Confirm’ status 

in ‘Review’ tab of the RayScan. 

8 

 

Acquired image is displayed in FMX View. 
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Stationary Acquisition Mode 

No. Figure Description 

1 

 

Select device type to RIOScan_RPS500 from 

Intraoral tab 

2 

 

Select the patient undergoing capturing then 

click on the [IO X-Ray Acqusition] button. 

 

Tip – Same function is performed by 

selecting the patient undergoing 

capturing from ‘patient list’ of the 

‘Search’ tab then clicking the [IO X-

Ray acq.] button on the bottom. 

3 

 

When information of the selected patient 

appears, click [OK] to continue capturing. 

By clicking the [Cancel] button,  

end capturing and return to ‘FMX’ tab. 

 

Caution – If device is not connected then 

cannot find device message 

appears and returns to  

the ‘FMX’ tab. 

4 

 

Click on the [Stationary] button to proceed to 

the stationary acquisition mode. 
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5 

 

When preparation for scan is completed, click 

on the [Scan] button. 

6 

 

When capturing is completed, the image is 

displayed in 3 separate locations; ‘FMX View’, 

‘Image Preview’ and ‘Thumbnail Image’. 

 

Tip - In no relation to capturing preparation, 

FMX 4 / 7 / 12 / 18 View and 

Sequential / Stationary conversion are 

available. 

7 

 

When capturing is repeated then the image is 

overlapped in the same position. 

Note that image thumbnail is added and the 

image count on the bottom of ‘Image Preview’ 

increases.   

Completed acquiring images may be moved  

to an alternate position via Drag, rotate or 

deleted. 

8 

 

 

When capturing is completed press the 

[Confirm] button to save the image and  

close the capturing window. 

If image is unused then click the [Reject] 

button and close the window. 

 

Tip - Image is not displayed on FMX screen 

by clicking the [Reject] button.  

For display convert to ‘Confirm’ status 

in ‘Review’ tab of the RayScan. 
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9 

 

Acquired image is displayed in FMX View. 

 

 

Rotate Image 

Before saving the acquired images, please rotate the images properly. 

No. Figure Description 

1 

 

Click [Right Rotate] or [Left Rotate] button  

on bottom of ‘Image Preview’ of the scanned 

image. 

 

Tip – From over the applicable image of  

the FMX View, click the right mouse 

button to rotate the image 90 degrees 

to the right. 

2 

 

Image is rotated. 

 

 

Move Image Position 

Before saving the acquired images, please move the image to proper position. 
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No. Figure Description 

1 

 

Click the left mouse button above the image 

required to be moved and Drag then drop  

the image at desired position.  

 

Tip – Same function is performed with a click 

and Drag of the thumbnail on bottom. 
 

Tip – Image transfer from FMX 12 -> 18 

View or 18 -> 12 View is enabled. 

2 

 

Image is rotated automatically according to 

rotate information of the applicable position. 

 

 

Delete Image 

Before saving the acquired images, please delete the images which you do not want to save. 

No. Figure Description 

1 

 

Click the [Delete] button upper right part of 

thumbnail.  

 

2 

 

When delete confirm message window appears 

click [Yes]. 

If deletion is not desired then click [No]. 

 

Caution – Deleted images cannot be 

restored. 
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3 

 

Applicable image is deleted from the thumbnail 

list. 

 

 

4.4.3 Save QuickScan Image 

RIOScan Browse Image provides to receive the QuickScan images from RIOScan device.  

 

Browse & Save Image of RIOScan 

No. Figure Description 

1 

 

Select device type to RIOScan_RPS500 from 

Intraoral tab.  

2 

 

Select the patient undergoing capturing then 

click on the [IO X-Ray Acqusition] button. 

 

Tip – Same function is performed by 

selecting the patient undergoing 

capturing from ‘patient list’ of the 

‘Search’ tab then clicking the [IO X-

Ray acq.] button on the bottom. 
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3 

 

When selected patient information appears, 

click [OK] to proceed to capturing. 

By clicking the [Cancel] button, end capturing 

and return to the ‘FMX’ tab. 

 

Caution – When SMARTDent cannot find 

device, it returns to the ‘FMX’ tab. 

4 

 

Click on the [Browse] button. 

5 

 

Thumbnails from connected RIOScan device 

shows on the screen. 

Select the images you want to get and click the 

[Get] button.  

 

Tip– The text on the top of the thumbnails 

show names for thumbnails.  

6 

 

When Browsing is completed then the image  

is displayed in 3 locations; ‘FMX View’,  

‘Image Preview’, ‘Thumbnail Image’.  

Drag the completed image to move to 

alternate position, rotate or delete. 

Tip – In no relation to imaging preparation, 

FMX 4 /7 /12 / 18 View and 

Sequential / Stationary conversion are 

available. 
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7 

 

Click [Confirm] to save images and close 

 the window. 

If image save is not required then click on  

the [Reject] button to close the window. 
 

Tip – Image is not displayed on FMX screen 

by clicking the [Reject] button.  

For display convert to ‘Confirm’ status in 

‘Review’ tab of the RAYSCAN. 

8 

 

Acquired image is displayed in FMX View. 

 

 

4.4.4 Delete QuickScan Image 

If there are images in RIOScan device, user can delete the images. 

 

CAUTION  Once delete QuickScan images, you cannot recovery the images.  

 

Delete QuickScan Image of RIOScan 

No. Figure Description 

1 

 

Click on the [Browse] button. 
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2 

 

Select images you want to delete and click the 

[Delete] button.  

3 

 

Delete image from Thumbnail Image List. 

 

4.5 Intraoral Camera Acquisition 

Select patient list from the ‘Search’ tab screen then either click the [Camera acq.] button on the 

bottom or [IO Camera Acq] from FMX tab screen to convert to the intraoral camera capturing 

screen. Intraoral camera capturing screen compositio n are as follows. 

 

 

Figure 2.  Intraoral Camera Acquisition Screen 

 

IO Camera Button 

Camera View 

Thumbnail View Capture Button 

Patient Information 

 

Device List 
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Device List 

Item Description 

Device list Show connected devices. 

 

IO Camera Button 

Item Description 

End Acq. Exit acquisition mode and converts to a save mode. 

Cancel Cancel acquisition and goes to the FMX tab. 

 

Camera View  

Displays real-time preview image of the connected camera. 

 

Thumbnail View 

Item Description 

Thumbnail List Thumbnail list of the captured image. 

Capture 
Captures the image displayed on Camera View. 

The image captured saved into thumbnail  
 

TIP 
Capture is available by using Space Bar of the keyboard and button of the connected 

device. 

 

Following indicates composition of the intraoral camera save screen. 
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Figure 3.  Intraoral Camera save screen 

 

 

 

IO Camera Button 

Item Description 

Retake Images taken already are trashed and returns to the IO camera acquisition screen. 

Confirm 
Saves all FMX View and Thumbnail View items then closes the acquisition screen. 

Items saved in FMX View are available for viewing from the FMX tab. 

Reject 
Rejects FMX View and Thumbnail View items then closes the acquisition screen. 

Reject images are stored in the server, but cannot be displayed in SMARTDent. 

12 FMX View screen is displayed for the deciduous teeth (12). 

18 FMX View screen is displayed for the permanent teeth (18).  

TIP 
Reject images can be changed to Confirm status in Review tab of the RayScan. 

Images changed to Confirm status can be displayed in Image and FMX. 

 

 

FMX View  

Images are arranged according to the FMX Layout. Drag the image from thumbnail list and place 

 Patient Information IO Camera Button 

FMX View 

Thumbnail View Trash Button 
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in FMX View then tooth number of the applicable position is also saved allowing display by position 

in the FMX screen. 

Images are rotated automatically according to the FMX View position and if rotate information is 

incorrect then click the right mouse button over the image to rotate image by 90 degrees in 

clockwise direction. 

 

Thumbnail View 

Item Description 

Thumbnail List 

Thumbnail list of the captured images. Images in the thumbnail list are 

saved without the tooth number during the save and not displayed on  

the FMX screen. 

Trash Deletes images. 

 

NOTICE 

Images designated in FMX 12, FMX 18 View are displayed by position in ‘FMX’ tab 

screen, but images in the thumbnail list on bottom are saved without the tooth 

number and available for viewing only in the ‘Image’ tab. 

 

Intraoral Camera Capturing 

No. Figure Description 

1 

 

Select the patient undergoing capturing then 

click the [IO Camera Acqusition] button. 

 

Tip – Same function is achieved by selecting 

the patient list from ‘Search’ tab then 

clicking [IO Cam acq.] button on the 

bottom. 

2 

 

When patient information appears click [OK] 

and proceed to capturing. 

Click the [Cancel] button to end capturing  

and return to the ‘FMX’ tab. 

 

Caution – If device is not connected then 
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cannot find device message 

appears and returns to  

the ‘FMX’ tab. 

3 

 

View the image displayed in [Camera View] and 

click on either the [Capture] button, [Space bar] 

or device button for capturing. 

4 

 

Thumbnail list is displayed on the bottom. 

When capturing is completed, click the  

[End acq.] button to enter the save mode. 

5 

 

Click the left mouse button on the image 

thumbnail intended to move and Drag then 

place in the desired position of the FMX View. 

6 

 

Image rotates automatically according to  

the FMX position.   

When moved to FMX View, the applicable 

image disappears from the thumbnail list  

on the bottom. 

 

Notice – Images arranged in FMX View 

includes the tooth number when 

saved, but thumbnail images  

on the bottom are saved without  

the tooth number.  

Images without a tooth number 

cannot be displayed in the FMX 

screen. 
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7 

 

To save, click on the [Confirm] or [Reject] 

button. 

To retake the image, click the [Retake] button. 

 

Tip – Image is not displayed in FMX screen 

when [Reject] button is clicked.  

To display, change to Confirm status  

in ‘Review’ tab of the RayScan. 

8 

 

Confirm that images are incorporated in the 

FMX screen by clicking the [Confirm] button. 

 

 

Rotate Intraoral Camera Image 

Image modification must be performed prior to clicking [Confirm] or [Reject] button. 

No. Figure Description 

1 

 

Click the right mouse button over the image. 

2 

 

Image rotates 90 degrees in clockwise 

direction. 
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Delete Intraoral Camera Image 

Image delete must be performed prior to clicking [Confirm] or [Reject] button. 

No. Figure Description 

1 

 

Select by clicking the thumbnail of the image 

intended for deletion. 

2 

 

Click the [Trash] button. 

Selected Thumbnail image is deleted. 

 

Tip – Same function is achieved by Dragging 

the thumbnail and place over the 

[Trash] button. 
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Export 

5 
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5  Export 
 

SMARTDent can be used to save image of the patient registered in the RayScan Alpha System into 

the designated media storage and during the save, user can setup the image format desired and 

Label of the saved folder.  

The storage mediums are CD Publishing, CD/DVD and USB type. 

For CD Publishing you can create CD comes with a Image Viewer easily. 

For CD/DVD you can use Close Media and Eject when finiched function, for USB you offer local 

Hard Disk function.. 

 ‘Export’ tab screen composition and contents of each item are as follows. 

 

 

 

Figure 4.  'Export' tab screen 

 

Export Image List Export Opation 

Bottom 
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Export Image List 

 

Item Description 

Patient ID ID of the registered patient 

Patient Name Name of the registered patient 

Patient Birth Date Birth date of the registered patient  

Patient Sex Gender of the registered patient 

Modality Imaging Modality of the registered image  

Series ID Series ID of the registered image 

 

 

Export Option 

 

Item Description 

Working Status Displays the progression status during Export. 

Media Storage Displays usable capacity / total capacity of the media storage. 

 

 

Media type(Publishing) 

 

Item Description 

Media Type Sets type of the media storage and save path. 

Addeditional files Select file to add into the CD. 
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Media type (CD/DVD) 

 

Item Description 

Media Type Sets type of the media storage and save path. 

Volume Label 

Becomes the best route folder for where Export image is saved in 

case of the USB Type and for CD/DVD Type becomes Label name 

of the applicable CD/DVD. 

Image Format 
Sets image format of the registered image during Export. 

JPG is set as standard and DICOM, RAW are additionally supported. 

Burn overlay Select whether or not to include an overlay image. 

Burn Acq. Info Select whether or not to include an image information 

 

 

Media type (USB) 

 

Item Description 

Media Type Sets type of the media storage and save path. 

Detail Path Full path of the save images except folder name 

Volume Label 

Becomes the best route folder for where Export image is saved in 

case of the USB Type and for CD/DVD Type becomes Label name 

of the applicable CD/DVD. 
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Image Format 
Sets image format of the registered image during Export. 

JPG is set as standard and DICOM, RAW are additionally supported. 

Burn overlay Select whether or not to include an overlay image. 

Burn Acq. Info Select whether or not to include an image information 

 

 

Bottom 

 

Item Description 

Remove 
Deletes the image selected by user from the Export Image List. 

Image remove can delete 1 image at one time. 

Remove All Deletes all images registered in the Export Image List. 

Export 
Begins Export in settings of the Export Option. 

Progression status of Export is displayed in the Working Status. 

Stop 
Cancels Export. 

Activated after Export has been initiated. 

 

5.1 Export Image Registration 

‘Export’ tab is in inactive condition when registered image does not exist. 

There are 2 methods for registering images in ‘Export’ tab, first method is to register all selected 

patient images from the ‘Search’ tab and second method is to register only the selected Series 

images in ‘Image’ tab. 

 

Export registration in ‘Search’ tab 

No. Figure Description 

1 

 

Search the patient from ‘Search’ tab. 

 

Notice – If select patient does not exist  

then [Export] button is inactive. 
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2 

 

Select the patient intended for Export then 

click the [Export] button on bottom of the 

‘Search’ tab screen. 

 

Notice – Multiple selections for patient 

selection is not available.  

To register 2 or more patients, 

[Export] button click after patient 

selection must be repeated. 

3 

 

When image registration successful message 

appears, click the [OK] button.  

4 

 

Goes to ‘Export’ tab automatically. 

 

Confirm that images of the patient selected in 

‘Search’ tab have been registered.  

 

 

Registration in ‘Image’ tab 

No. Figure Description 

1 

 

Select the image intended for Export from  

the ‘Image’ tab. 
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2 

 

Click the [Modality] button of the upper right 

image thumbnail.  

3 

 

Select ‘Export’ from the appearing pop-up 

menu. 

4 

 

Registration successful message appears then 

converts automatically to the ‘Export’ tab.  

 

 

 

5.2 Delete Export Item 

Delete items registered in the ‘Export’ tab. Deleting images registered in Export implies that deletion 

occurs only from the ‘Export Image List’, but the original image is not deleted. After all items 

registered in ‘Export’ tab are deleted, screen changes automatically to ‘Search’ tab. 
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Delete Selected Export Item 

No. Figure Description 

1 

 

Select the items to be deleted. 

2 

  

Click the [Remove] button on bottom. 

3 

 

In the delete confirm message window,  

click [Yes]. 

4 

 

Confirm that selected items have been deleted. 

 

Notice – When all items are deleted then 

changes to ‘Search’ tab 

automatically. 
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Delete All Export Item 

No. Figure Description 

1 

  

Click the [Remove All] button on bottom. 

2 

 

In the delete confirm message window, 

click [Yes]. 

3 

 

Return to ‘Search’ tab. 

 

Notice If all lists on the ‘Export’ tab are deleted the screen return to ‘Search’ tab. 
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5.3 Image Export 

Export images by designating the media storage, save path and save format. 

the media storage are CD Publishing, CD/DVD and USB type. For USB type we offer DICOM, Raw, 

Jpg image type to export.. 

 

Image Export 

No. Figure Description 

1 

  

Check the images in the list are right. 

2 

 

Setup ‘Export Option’ such as Media Type, 

Export Type and etc. 

3 

 

Click the [Export] button. 
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4 

 

Export progression status is displayed in 

Working Status and when Export completed 

message window appears,  

click the [OK] button. 

5 

 

Go to the applicable path and confirm  

the Export result.  

 

Notice – Each image is saved in [SeriesID]_ 

[ExportTime] format folder. 

Ex) SeriesID – S20121009132636 

Time – 2012.10.09 14h 21m 39s 

S20121009132636_20121009142139 
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6 Import 
 

In SMARTDent the images taken previous can be registered into the RayScan Alpha System with 

simple click of a button by using the ‘Import’ function. 

 

For user convenience, image Import functions of various format are supported. Supported image 

formats include DICOM Image, Raw Image, and JPG/BMP as well as screen captured images are 

supported for Import. 

 

‘Import’ tab screen composition and contents of each item are as follows. 

 

 

Figure 5.  'Import' tab screen 1 

 

 

Folder View 

 

Import Type 

 

Import Image List 

 Bottom 

Refresh 
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Figure 6.  'Import' tab screen 2 

 

Import Type 

 

Item Description 

DICOM Imports DICOM format Images. 

Window 
Imports general Window Image format Images. 

Supported image format: JPG / BMP / TIF / GIF / PNG 

Raw 

Imports Raw file format Images. 

When Importing Raw files, the exact image information of the image 

intended for Import must be known to user. 

Screen Imports screen captured images. 

 

 

 

 

Import Operation 

 

Import 

Image List 
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Folder View 

Assigns folder location of the Import targeted image file. 

Folder View is used in DICOM / Window / Raw tab, but not used in Screen. 

Item Description 

Folder View 
Displays in Tree format the Local Folder List of the PC operating the 

SMARTDent used to select the search folder required for Import by user. 

Search Subfolder Searches for images in the selected folder and sub-folder. 

Search Button Initiates the image search. 

 

Import Image List 

Click the [Search] button to display list of the retrieved images. 

If selected tab is in DICOM mode then the retrieved images are shown in the list form,  

but in other tabs the retrieved image list is shown in the thumbnail form. In case of Raw file, blank 

space instead of thumbnail is displayed until exact image information is entered. 

 

Import Option – Patient Information 

 

Item Description 

Patient ID Patient ID of the registered Image 

Patient Name Patient name of the registered Image 

Patient Birth Date Patient’s birth date of the registered Image 

Patient Sex Patient gender of the registered Image 

Auto Automatically creates patient ID of the registered Image. 

Search Searches information of a patient previously registered.  

Screen Keyboard 
Calls for a screen keyboard used in an environment where typical 

Keyboard use is not feasible such as the Chair. 

Calendar Calls for a calendar that allows selecting dates with the mouse.  
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Import Option – Study Information 

 

Item Description 

Study ID Study ID of the registered Image 

Study Description Study Description of the registered Image 

 

Import Option – Import Information 

 

Item Description 

Modality Modality of the registered Image 

Pixel Spacing X. Y X and Y Pixel Spacing of the registered Image 

Kilovoltage Imaging kVP specification of the registered Image 

Milliampere Imaging mA specification of the registered Image 

Exposure Time Imaging exposure time of the registered Image 

 

Import Option – RawImage Attributes 

 

Item Description 

Rows(Height) Height of the registered Image 
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Columns(Width) Width of the registered Image 

Allocated Bits Allocated Bits of the registered Image 

Stored Bits Stored Bits of the registered Image 

Samples Per Pixel Samples Per Pixel of the registered Image 

Pixel Representation Data format type of the registered Image 

Refresh Preview 
Raw Image Attributes is applied to the searched List to refresh 

thumbnail. 

 

 

Import Option – General Anatomy Option 

 

Item Description 

Patient Orientation 

Patient position information of the registered Image 

Here the first letter shows which position of the patient the right side of 

the image is indicating and the second letter shows which position of  

the patient the bottom of the image is indicating.   

[L] - Left,  [F] - Foot,  [P] - Posterior,  [A] - Anterior 

Image Laterality 

Patient direction information of the registered Image 

B[Both] shows the left, right symmetry of the image presently displayed. 

R[Right] represents the right side, L[Left] the left side and U[Unpair] 

represents the left / right asymmetrical image. 

 

Bottom 

 

Item  Description 

Paste 
Used only in the Screen tab.  

Registers captured image as thumbnail. 

Delete 
Used only in the Screen tab.  

Deletes the selected thumbnail. 

Select All 
Selects all registered image list. 

If no registered image exists or image list is all selected then button becomes 
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inactive. 

Clear All 
Cancels selection of the selected image list. 

If there is no selected image list then the button becomes inactive. 

Import 
Initiates Import of the selected images. 

Import progression status is displayed in “%” on the screen. 

 

 

6.1 DICOM Image Import 

Imports files whose file extension is dcm. 

Image information is analyzed automatically for the image list display during image search by 

clicking the [Search] button. 

  

Dicom Image Import 

No. Figure Description 

1 

 

Select the ‘DICOM’ tab from ‘Import’ tab. 

2 

 

Select the path where DICOM Image is located 

from the ‘Folder View’ then click the [Search] 

button. 
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3 

 

Select the desired item from the retrieved 

image list. 

4 

 

Click the [Import] button on bottom to initiate 

image Import. 

5 

 

When Import completed message window 

appears then click [OK] and close the window 

check the registered images in the ‘Search’ tab. 

 

 

6.2 Window Image Import 

Imports Windows image files with file extension jpg, bmp, png, tif or gif 

Manual setting is required since patient and imaging information does not exist.  
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Windows Image Import 

No. Figure Description 

1 

 

Select ‘Window’ tab from the ‘Import’ tab. 

2 

 

Select the path where Window Image is  

located from ‘Folder View’ then click  

the [Search] button. 

3 

 

Enter patient information and image 

information required for Import. 

4 

 

Select the desired image from thumbnail of  

the searched images. 
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5 

 

 

If selected Modality is ‘IO’ then click the FMX 

View you want.  

 

If selected Modality is ‘OT’ then click the  

[Show FMX View] button on bottom and  

use the FMX View Layout. 

 

If FMX View Layout is not used then click  

the [Hide FMX View] button. 

6 

 

Left mouse button over the image intended for 

Import and Drag then place in desired position 

of the FMX View. 

You can move images to other position or 

delete to drag them. 

 

7 

 

Click the [Import] button to proceed to Import.   

8 

 

When Import completed message window 

appears then click [OK] and close the window 

then check the registered image in ‘Search’ tab. 
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6.3 Raw File Import 

Imports files with file extension raw. 

Manual setting is required since patient, imaging as well as image information does not exist.  

If image information is incorrect the image cannot be displayed hence information pertaining to 

‘RawImage Attributes’ must be entered prior to Import then click the [Refresh Preview] button and 

confirm that thumbnail is displayed correctly. 

 

Raw Image Import 

No. Figure Description 

1 

 

Select ‘RAW’ tab from the ‘Import’ tab. 

2 

 

Select the path where RAW Image is  

located from ‘Folder View’ then click  

the [Search] button. 

3 

 

Enter patient information and image 

information required for Import. 
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4 

 

After entering Raw File information into 

‘RawImage Attributes’, click the [Refresh 

Preview] button to confirm that Preview 

thumbnail image on the right is displayed 

correctly.  

 

Caution – Image cannot be displayed if  

Raw File information is entered 

incorrectly.  

Confirm proper display of the 

Preview thumbnail image during 

Raw image Import. 

5 

 

Select the desired image from the retrieved 

image thumbnail.  

6 

 

Click the [Import] button on bottom to proceed 

to Import. 

7 

 

When Import completed message window 

appears, click [OK] and close the window then 

check the registered image in ‘Search’ tab. 
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6.4 Screen Capture Import 

Function which executes capture from the affiliates’ programs and saves the captured screen by 

pressing ‘PrtScn’ key on the keyboard in the SMARTDent server.  

Capture the screen and click the [Paste] button on bottom of the ‘Screen’ tab then thumbnail is 

registered in the image list on the right and since the applicable image lacks patient and imaging 

information, manual setting process is required.  

 

 

Captured Image Import 

No. Figure Description 

1 

 

Select ‘Screen’ tab from the ‘Import’ tab. 

2 

 

After screen capture, click the [Paste] button on 

bottom to upload the thumbnail in ‘image list’ 

on the right side.  

 

Notice – When no capture image exists then 

the thumbnail is not registered 

after [Paste] button is clicked. 

3 

 

Select desired image of the patient from  

the registered List.  
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4 

 

Enter patient information and image 

information required for Import. 

5 

 

Click the [Import] button to initiate Import. 

6 

 

When Import completed message window 

appears, click [OK] and close the window then 

check the image registered in ‘Search’ tab.  
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7 Configuration 

 

Modify setting values used in the SMARTDent program. 

Click the [Configuration] button on upper right side of the program to enter the applicable screen. 

‘Configuration’ tab screen composition and contents of each item are as follows.  

 

 

Figure 7.  'Configuration' Screen 

 

Contents 

Item Description 

Common Setup the Language and date format. 

Institution Setup the institution information. 

Patient ID Keyboard Type Setup the keyboard type for patient ID 

Patient Name Display Format Setup the patient name format. 

Server Changes the server settings. 

Contents 

Bottom 
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General Changes the general settings. 

Viewer Changes settings for the external program link. 

DICOM Changes settings for the record during DICOM file creation. 

Implant Changes settings associated with the Implant. 

IO Camera Changes settings related to the intraoral camera. 

DICOM Print SCP Changes the DICOM Print SCP settings. 

 

Bottom 

Item Description 

Save Saves the changed setting values and closes the Configuration screen. 

Cancel Closes the Configuration screen without saving the changed setting values. 

 

 

7.1 Language Setting 

Change Language Setting 

No. Figure Description 

1 

 

Select language.. 

We offer 7 languages for SMARTDent.(Korean, 

English, French, Japanese, Russian, Polish, 

Spanish) 

Languages not translated yet is displayed to 

English. 

2 

 

If select language “Language settings are 

applied after application end.” Message will 

appear. 



SMARTDent  l  Configuration 

156 

3 

 

Click [Save] button at the buttom, end the 

program and run it again.  

  

4 

 

You can see the language is changed that you 

choose. 

 

7.2 Date Foramt Setting 

Change Date Format Setting 

No. Figure Description 

1 

 

Select the desired date format. 

 

Notice – y means year, M means month, d 

means day.. 

2 

 

When select Date Format “Date format settings 

are applied after application end” message 

will appear. 
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3 

 

Click [Save] button at the buttom, end the 

program and run it again.  

 

4 

 

You can see the date format is changed that 

you choose. 

 

7.3 Institution Information Setting 

Institution Information Change 

No. Figure Description 

1 

 

Enter changed institution and institution 

director’s name.  

Move the mouse over to top of the institution 

logo image to activate the [Change] button.  

Click the [Change] button and change the 

institution logo. 

2 

 

Click the [Save] button on bottom of the screen 

and save the changes. 
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7.4 Patient ID Keyboard Type Setting 

Change Patient ID Keyboard Type 

No. Figure Description 

1 

 

Select keyboard type for patient ID search from 

Search tab.  

2 

 

Click [Save] button at the bottom and save the 

changes. 

 

3 

 

Click [Keyboard] button ID search view from 

search tab. 

Check if the keyboard type is changed.  

 

 

7.5 Patient Name Format Setting 

Change a patient name format.   

There are two different format for patient name. One is Full Name Format, the other is Last/First 

Name Format.  
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Patient Name Format change  

No. 그 림 설 명 

1 

 

Select patient name format from Patient Name 

Display Format tab. 

2 

 

Click [Save] button at the bottom and save the 

changes. 

3 

 

Click New button from Search tab and Confirm 

that the patient name format is changed. 
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7.6 SMARTDent Server Setting 

Change setting for SMARTDent Server and Sharing Image Service. 

All patient and image information are saved to the SMARTDent server. 

Patient information and image information in SMARTDent are retrieved by approaching the server 

therefore the server setting is essential.  

Image Sharing Service offers to upload images to remote server for sharing of images.  

The service user should insert proper ID and password. 

CAUTION 

Image Sharing Service 

Accodring to the service user, the number of images for sharing is limited and 

uploaded images will be deleted periodically. 

 

 

Server Setting Change 

No. Figure Description 

1 

 

Enter IP address of the changed server in the 

‘Web Service’ field. 

2 

 

Click the [Verify] button and proceed to the 

server connection test. 
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3 

 

When test successful message window appears, 

click the [OK] button. 

4 

 

When server setting change complete message 

window appears, click the [OK] button.  

 

 

Image Sharing Service Setting 

No. Figure Description 

1 

 

Check ‘Use Sharing Service’.  
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2 

 

Enter the ID and Password and click [Login] 

button. 

3 

 

When Login Success Message appears, click 

[yse] button to save and apply user 

information. 

4 

 

When user information apply success message 

appears, click the [OK] button. 

 

5 

 

Click the [Save] button at the bottom of the 

screen to save the settings.  
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6 

 

Click the [Modality] button on upper right side 

of the image thumbnail from the lower  

‘Patient List’.  

 

 

Select ‘Share’ menu from the pop-up menu to 

share this image(s).  

 

Notice – CT images do not provide this 

function. 

7 

 

When image sharing completed message 

appears, click the [OK] button. 

8 

 

Confirm the shared images in the website.  
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7.7 RIOView Server/Client Setting 

Through the server/client setting of RIOView, user of intraoral x-ray device can share the acquired 

images without server installation. RIOView work as server mode when it install. User can chage the 

setting in the configuration as below. 

 

Change to Server Mode 

No. Figure Description 

1 

 

Change ‘RIOView Type’ to Server.  

2 

 

When connection success message appears, 

click the [OK] button. 

3 

 

Click the [Save] button at the bottom of the 

screen to save the settings and restart RIOView.  
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4 

 

Confirm RIOView works in Server Mode. 

 

 

Change to Client Mode 

No. Figure Description 

1 

 

Change ‘RIOView Type’ to Client. 

2 

 

Enter the User Information(user name and 

password) and Server IP. 

Click the [Verify] button and proceed to the 

server connection test. 
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3 

 

When connection success message appears, 

click the [Yes] button to save the connect 

information. 

4 

 

When server setting change complete message 

appears, click the [OK] button. 

5 

 

Click the [Save] button at the bottom of the 

screen to save the settings and restart RIOView.  

6 

 

Confirm RIOView works in Client Mode. 

 

 



SMARTDent  l  Configuration 

167 

7.8 Tooth Numbering Setting 

Change a dental notation setting 

No. Figure Description 

1 

 

Click the [Tooth numbering] section and 

change the setting. 

2 

 

Click the [Save] button at the bottom of the 

screen to save the settings. 

3 

 

You can see the dental notation is changed. 
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7.9 Unit of Length Setting 

Change the setting for Unit of Length 

No. Figure Description 

1 

 

Click the [Unit of Length] section and change 

the setting. 

2 

 

Click the [Save] button at the bottom of screen 

to save the settings. 

3 

 

You can see that the Unit of Length Setting is 

changed.  
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7.10 Decimal Places Setting 

Change Decimal Places 

No. Figure Description 

1 

 

Click [Decimal Places] section and change the 

setting. 

 

Notice – Changed Decimal Places is applied 

to image view and it affect to length 

information. 

2 

 

Click the [Save] button at the bottom of screen 

to save the settings. 

3 

 

You can see the Ciphers String Setting is 

changed when the length or angle measuring. 
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7.11 Default Searching type setting 

Change the setting for Default Searching Type 

No. Figure Description 

1 

 

Coose ‘Default Search Type’ [Searching today 

patient] or [No Searching]. It is for searching 

type when SMARTDent first run.  

2 

 

Click the [Save] button at the bottom of screen 

to save the settings. 

3 

 

When SMARTDent first run, it shows ‘Today 

patient list’ or not depending on the searching 

type.  
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7.12 Patient ID Searching Type setting 

Change the setting for Patient ID Searching Type 

No. Figure Description 

1 

 

Coose ‘Patient ID Search Type’ It is for 

searching type for patient ID.  

2 

 

Click the [Save] button at the bottom of screen 

to save the settings. 

3 

 

When searching patient with patient ID the 

result shows depending on the patient ID 

searching type.  
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7.13 Image Overlay Setting 

It is a function to set the show/hide oprtion for guide ruler, image position indicator, and DAP(Dose 

Area Product) value on Image tab. 

 

Change Ruler Setting. 

No. Figure Description 

1 

 

Set Ruler function to check Show/Hide 

checkbox of Ruler. 

 

Notice –Ruler displys at the left and bottom 

of images. 

2 

 

Click the [Save] button at the bottom of screen 

to save settings. 

 

3 

 

The Ruler displys at the left and bottom of 

images. 
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Change setting for Image position 

No. Figure Description 

1 

 

Set Image position function to check 

Show/Hide checkbox of Image position.  

 

Notice – Image Position displays at the left 

and bottom of images.  

 

2 

 

Click the [Save] button at the bottom of screen 

to save settings. 

3 

 

Image Position information displays at the  

left and bottom of images.  
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Use DAP Setting Change 

No. Figure Description 

1 

 

Check ‘Use DAP Display’. 

 

2 

 

Click the [Save] button on bottom of the screen 

and save the changes. 

3 

 

Confirm the DAP on the bottom right in Image 

tab. 
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7.14 DICOM Setting 

Encoding type according to the language setting must be designated. Patient information could 

appear incorrectly if encoding type is incorrectly assigned. 

  

Encoding Type Setting Change 

No. Figure Description 

1 

 

Click the ‘Encoding Type’ category to change 

the encoding type setting. 

 

Notice – Changed encoding type has an 

effect during DICOM file creation. 

2 

 

Click the [Save] button on bottom of the screen 

and save the changes. 

 

 

7.15 Implant Setting 

From the ‘Image’ tab, setup the Implant manufacturer and Implant color to be used during 

Implant insertion. 

Selected manufacturer is added as a button in the Implant select window and by clicking the 

button the applicable manufacturer’s Implant list is shown.  
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Change Implant color 

No. Figure Description 

1 

 

Select one of the default, red, green , blue, 

yellow. 

 

Notice – Selected color is applied into all 

implant of images immediately.  

2 

 

Click the [Save] button on bottom of the screen 

and save the changes. 

3 

 

 

Implant Manufacturer Setting Change 

No. Figure Description 

1 

 

Click the ‘1st Manufacture, 2nd Manufacture  

And 3rd Manufacture’ fields separately then 

select the Implant manufacturer. 

 

Notice - Selected Implant manufacturer is 

added as a button on the bottom 

during ‘Image’ tab Implant selection 

and Implant of the applicable 

manufacturer is listed.  
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2 

 

Click the [Save] button on bottom of the screen 

and save the changes. 

3 

 

You can see when inserting Implant the Implant 

Manufactture is added. 

 

 

7.16 Intraoral Sensor Setting 

You can set TWAIN function, Sensor type, FMX mode, and Pano-FMX function. 

 

Set IO Sensor TWAIN Version 

No. Figure Description 

1 

 

Check ‘Use TWAIN in Intral-Oral Sensor’ in 

Intraloral section. 
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2 

 

Choose TWAIN version you want to use and 

then click the [Save] button. 

 

Set ‘Use TWAIN in Intral-Oral Sensor’ 

No. Figure Description 

1 

 

Check ‘Use TWAIN in Intral-Oral Sensor’ in 

Intraloral section. 

2 

 

Set image reversion option and click the [save] 

button at the bottom of screen to save the 

setting. 
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Set IO Sensor Type 

No. Figure Description 

1 

 

Select sensor type in Intraloral section. 

2 

 

Click the [Save] button to save the settings.  

 

 

Set FMX-Mode 

No. Figure Description 

1 

 

Click [FMX mode] in Intraoral section and select 

FMX mode you want. 
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2 

 

Click [Save] buttin at the bottom of screen to 

save setting.  

3 
 

Check FMX-Mode is changed.. 

 

 

Set Maximum Image Scale  

No. Figure Description 

1 

 

Click [Maximum Image Scale] in Intraoral 

section. 

 

Notice –It is for Intraoral image when you 

want to display it smaller than the screen 

size. 

 

2 

 

Select Maximum Image Scale type you want. 
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3 

 

Click the [Save] button to save the settings. 

 

Use Pano-FMX  

No. Figure Description 

1 

 

 

Check [Pano-FMX] in Intraloral section. 

2 

 

Click [Save] buttin at the bottom of screen to 

save setting. 

3 

 

Check [Pano-FMX] is applied in Image tab. 
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7.18 IO Camera Setting 

Set Intraoral Camera TWAIN Version 

No. Figure Description 

1 

 

Check ‘Use TWAIN in Intral-Oral Camera’ in IO 

Camera section. 

2 

 

Choose TWAIN version you want to use and 

then click the [Save] button. 

 

 

Intraoral Camera Setting Change 

No. Figure Description 

1 

 

Select the IO camera to be connected from  

the Device List. 
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2 

 

Click the [Save] button on bottom of the screen 

and save the changes. 

 

 

Use Custom IO Camera Capture Key 

No. Figure Description 

1 

 

Check [Use Custom IO Camera Capture Key] 

from IO Camera section. 

2 

 

Click textbox and insert key you want to use 

for capture key.  

3 

 

Click the [Save] button on bottom of the screen 

and save the changes. 
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7.19 DICOM Print SCP Setting 

Add Print SCP 

No. Figure Description 

1 

 

Click [New] button. 

2 

 

When pop-up window for adding ‘Print SCP’ 

appears, enter AE Title, IP address and Port 

number. 

3 

 

Click the [OK] button. 

4 

 

Click the [Save] button on bottom of the screen 

and save the changes. 
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Modify Print SCP 

No. Figure Description 

1 

 

Click on the ‘Print SCP’ item intended for 

modification and select. 

2 

 

Click the [Modify] button. 

3 

 

Modify changes in the ‘Print SCP’ modification 

screen. 

4 

 

Click the [OK] button. 

5 

 

Click the [Save] button on bottom of the screen 

and save the changes. 
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Delete Print SCP 

No. Figure Description 

1 

 

Click on the ‘Print SCP’ item intended for 

deletion and select. 

2 

 

Click the [Delete] button. 

3 

 

In the delete confirm message window,  

click [Yes]. 

4 

 

Confirm that selected item is removed from  

the ‘Print SCP’ list then click the [Save] button 

on bottom of the screen to save changes.  
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7.20 Favorite Toolbar Setting 

Set Favorite Toolbar. 

No. Figure Description 

1 

  

Check [Use Favorite Toolbar]. 

2 

  

When [All tools] section is enabled select tools 

you want to use.  

3 

  

If you choose items, click [>] button to move 

the items to Favorite Items section.  

 

Notice – Up to 11 items can be selected  

4 

  

Click the [Save] button on bottom of the screen 

and save the changes. 
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Remove items from Favorite Toolbar 

No. Figure Description 

1 

 

Select items from ‘Favorite Items’ section.. 

2 

 

If you choose items, click [<] button to move 

the items to ‘Total Items’ section.  

3 

 

Click the [Save] button on bottom of the screen 

and save the changes. 
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Remove all items from Favorite Toobar 

No. Figure Description 

1 

 

Click [<<] button to move all items to ‘Total 

Items’ section.  

2 

 

All items in ‘Favorite Items’ section will be 

moved to ‘Total Items’ section. . 

Click the [Save] button on bottom of the screen 

and save the changes. 

 

Notice – If you save settings without seleted 

itmes the ‘Use Favorite Toolbar’ 

function is unchecked automatically. 
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